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Classification of Safety-Related Notices

> B P

This manual contains notices which you should observe to ensure your own perso-
nal safety, as well as to protect the product and connected equipment. These noti-
ces are highlighted in the manual by a warning triangle and are marked as follows

according to the level of danger:

Danger

indicates that death or severe personal injury will result if proper precautions are
not taken.

Warning

indicates that death or severe personal injury can result if proper precautions are
not taken.

Caution

with warning triangle indicates that minor personal injury can result if proper
precautions are not taken.

Caution

without warning triangle indicates that damage to property can result if proper
precautions are not taken.

Notice

indicates that an undesirable result or status can result if the relevant notice is
ignored.

Note

highlights important information on the product, using the product, or part of the
documentation that is of particular importance and that will be of benefit to the
user.
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Trademarks

SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of
SIEMENS AG.

Third parties using for their own purposes any other names in this document which
refer to trademarks might infringe upon the rights of the trademark owners.

Safety Instructions Regarding your Product:
Before you use the product described here, read the safety instructions below tho-
roughly.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment.
Qualified persons are defined as persons who are authorized to commission, to
ground, and to tag circuits, equipment, and systems in accordance with establis-
hed safety practices and standards.

Correct Usage of Hardware Products
Note the following:

ii Warning
This device and its components may only be used for the applications described in
the catalog or the technical description, and only in connection with devices or
components from other manufacturers which have been approved or
recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set
up, and installed correctly, and operated and maintained as recommended.

Before you use the supplied sample programs or programs you have written
yourself, make certain that no injury to persons nor damage to equipment can
result in your plant or process.

EU Directive: Do not start up until you have established that the machine on which
you intend to run this component complies with the directive 89/392/EEC.

Correct Usage of Software Products
Note the following:

ii Warning
This software may only be used for the applications described in the catalog or the
technical description, and only in connection with software products, devices, or
components from other manufacturers which have been approved or
recommended by Siemens.

Before you use the supplied sample programs or programs you have written
yourself, make certain that no injury to persons nor damage to equipment can
result in your plant or process.

SIMATIC NET NCM S7 for PROFIBUS
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Prior to Startup
Prior to startup, note the following:

Caution

Prior to startup, note the information and follow the instructions in the latest
documentation. You will find the ordering data for this documentation in the
relevant catalogs or contact your local Siemens office.

Copyright © Siemens AG 2001 / 2002 All rights reserved

The reproduction, transmission or use of this document or its contents is not
permitted without express written authority. Offenders will be liable for
damages. All rights, including rights created by patent grant or registration of
a utility model or design, are reserved.

Siemens AG
Automation and Drives

Postfach 4848, D-90327 Nuernberg

Disclaimer of Liability

We have checked the contents of this manual for agreement with the hard-
ware and software described. Since deviations cannot be precluded entirely,
we cannot guarantee full agreement. However, the data in this manual are
reviewed regularly and any necessary corrections included in subsequent
editions. Suggestions for improvement are welcomed.

Technical data subject to change.

Siemens Aktiengesellschaft
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Preface

Aims

How to Achieve
Your Aims

Requirements

Audience

Scope of the
Manual

You want to install our SIMATIC S7 CPs in your system and make
optimum use of them.

This primer will help you to become familiar with handling NCM S7 for
PROFIBUS, the configuration tool for S7 CPs. Based on the
configuration and sample programs supplied with NCM, we will
introduce you to the typical steps required to make optimum use of
NCM S7 for PROFIBUS with your SIMATIC S7 CPs.

Aims of the Primer... ...How to Achieve the Aims

You can learn how to use the ...by working through the steps

product effectively in a short described using the supplied

time... sample with a suitable system
configuration.

You can learn how to use the ...by using the description to

product extremely effectively support you when you first

taking somewhat more time... | configure and program an
application of your own.

You should be familiar with the basics of STEP 7, in other words, you
should know the following:

How to work with STEP 7
Which function STEP 7 provides for managing hardware and software

How to handle projects

This primer is intended for installation personnel and STEP 7
programmers as well as for service personnel.

This primer applies to Version V5.2 and higher of the NCM S7
configuration software and to Version V5.0 and higher of the STEP 7
software.

SIMATIC NET NCM S7 for PROFIBUS
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Preface

Further For further information about STEP 7 documentation and the product,
Information... please refer to the accompanying manual “NCM S7 for PROFIBUS".

For further information about installing the NCM S7 for PROFIBUS
software, please refer to the readme file.

Note

Please note that the readme file for NCM S7 for PROFIBUS may
contain further information about the sample programs described in
this primer.

Conventions The following conventions are used in the primer:

¢ References to other manuals and documentation are indicated by
numbers enclosed in slashes /.../. These numbers refer to the titles of
manuals listed in the appendix.

e Actions you are required to perform are indicated by the symbol "»»”

4
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1 Overview of the Steps

Based on the sample configuration and the sample program “PROJECT PROFIBUS”, the
primer will guide you through the following steps in the next chapters:

Chapter 2 ‘
“PROJECT-PROFIBUS”

1. Create/open your project

It is advisable to create all the
system data “offline”. The data
can then be changed, saved and
downloaded at any time. The
basis for this is the STEP 7
project.

2. Configure and network your hardware

You specify the components of your
system. Base your selection on the
listin Chapters. 3, 4 and 5.

Chapter 3 Chapter 4 Chapter 5 Chapter 6
FDL S7<—>S7 | FDL S7<->S5 | DP S7<->S7 FMS S7<—>S7

3. Configure communications service Chapters 3 and 4:

FDL connections
* Chapter5:
DP master system

* Chapter 6:
FMS Connections

4. Write your user program

You convert your control task to
an S7 user program. You can
use, for example, the STL

notation.

5. Startup/diagnostics

If you encounter problems, you can
investigate the S7 stations with the
online tools of STEP 7/STL and
NCM diagnostics.

To achieve success quickly...

If your system configuration corresponds to the configuration selected for the sample, you can
download the sample data directly to the S7 stations in steps 2, 3 and 4!

SIMATIC NET NCM S7 for PROFIBUS
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Overview of the Steps

You will, however, learn more by working through TIP |
the steps as outlined in this primer. ' Skip the functions you alreadyl
" know. 1

,,,,,,,,,,,,,,,,,,,,,,

SIMATIC NET NCM S7 for PROFIBUS
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2 “PROJECT PROFIBUS”
STEP 7 Samples for PROFIBUS CPs

This chapter explains how you can use the “PROJECT PROFIBUS”
with the configurations and programs for the communications samples.

How the chapter will help you:

¢ You will get to know how to create a project with CPs

¢ You will get to know all the steps involved in configuration

Requirements:

A working knowledge of STEP 7, experience with STL, a
basic knowledge of PLCs.

If you require detailed information about the other
functions of the configuration software, please refer to
the corresponding manuals. This chapter also contains
references to specific manuals.

Contents:

— Create/open your project 10
— Configure and network your hardware 13

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C11.3-03 9



“PROJECT PROFIBUS”

1. Create/open your project

User programs and an image of the
S7 stations are managed in the
STEP 7 project.

| 2. Configure and network your hardware

After installation of the NCM S7 optional software, the sample project is located in the project
folder of STEP 7, for example in the folder
C:ASIEMENS\STEP7\EXAMPLES\PROJECT-PROFIBUS.

If you want to use the project in the S7 folder, follow the steps outlined below:
»~ Start the SIMATIC Manager.
»” Open the supplied sample project PROJECT-PROFIBUS with File » Open » Project....

QSIMATIC Manager - [PROJECT-PROFIBUS -- D:ASiemens\5tep7\Examples\expb]

%Eile Edit Inzert PLC “iew Options ‘Window ﬂFrom the Sample program dlsplayed

) =2 R = E% here, you move on to the steps described
=R = in the following sections.
E-E FMS-Client 57 400-Stat o B =i
=@ cPudta FMSCliert 57 FMS-Server 57 SIMATIC 300 SIMATIC 300
==z 57-Programm(1 400-5tat. 400-5tat. DP-Master DP-Slave
~{E] Quellen
(g Baustein % 2 T —]
- OP 4435 Basic(1 il o -
Sl FMS-Gerver 57 400-Grat SIMATIC SIMATIC SIMATIC SIMATIC 55(1)
EI CPU414-1[1) 300-Station(1) 300-Station(2] 300-Station(3)
H-{=5] S7-Progranm
=-JfF CP 4435 Basicl2) :._E E!-E
E-F SIMATIC 300 DP-Master
E-F SIMATIC 200 DP-Slave MPI (1) PROFIBUS (1)
-l SIMATIC 300-Station(1]
E-F SIMATIC 300-Station[2]
-l SIMATIC 300-Gtation[3]

Prezz F1 to get Help.

The sample project contains a PROFIBUS subnet. If you want
to create a new or further PROFIBUS subnet or a different

biect For more informa- ]
object, tion... Manual
V¥ Select the menu command Insert» ... » ... 121
Volume 1
Chapter 2

SIMATIC NET NCM S7 for PROFIBUS
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“PROJECT PROFIBUS”

If you want to create a working version of the PROFIBUS sample project...

»~ ...Use the menu command File » Save As to create a copy of the sample project in any
folder you wish.

The following table shows the configurations in the individual stations. This will also indicate
how much of the sample you can use directly and the extent to which you will have to adapt the

sample.
Station CP Type PROFIBUS | Communicate Description
Address s With station

SIMATIC 300 CP 342-5 2 SIMATIC 300 | Communication via the

station(1) station(2) SEND/RECEIVE interface with the
CP 342-5.
Data are transmitted in both directions.
The FCs AG_SEND and AG_RECV
are used.

SIMATIC 300 CP 342-5 6 SIMATIC 300

station(2) station(1)

SIMATIC 300 CP 342-5 8 S5 station(1) Communication via the

station(3) SEND/RECEIVE interface with the
CP 342-5.
The user program is adapted to the
program sample of the CP 5431.

SIMATIC S5(1) | CP 5431 4 SIMATIC 300

station(3)

SIMATIC 300 CP 342-5 10 SIMATIC 300 | Communication using the DP protocol

DP master DP slave with the CP 342-5.
The user program in the DP master
transfers “output data” to a DP slave
and reads the input data from the DP
slave.

SIMATIC 300 CP 342-5 12 SIMATIC 300

DP slave DP master

FMS client CP 443-5 14 FMS server Communication on FMS connections

S7-400 station | Basic S7-400 station | with the CP 443-5 Basic.
The user program in the FMS client
reads and writes data (variables) with
various structures on the FMS server.

FMS server CP 443-5 16 (without own

S7-400 station | Basic initiative)

SIMATIC NET NCM S7 for PROFIBUS
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“PROJECT PROFIBUS”

You have already created a configuration

If you have already created a configuration and simply want to use the sample programs for
your CPU, follow the steps outlined below:

»~ Copy the sample programs (container with S7 programs) of the station from the sample
project to the CPU of your existing project. Make sure that blocks do not overlap.

»~ Make sure that the hardware configuration and networking and the configured connections
are adapted according to the descriptions below.

Summary of step 1 “Creating the Project”:
You have created a STEP 7 project
— in which you can configure your system

— and in which you can create and save your user programs.

SIMATIC NET NCM S7 for PROFIBUS
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“PROJECT PROFIBUS”

| 1. Create /open your project m
* Which components does the system

2. Configure and network your hardware include?

* How are the components attached to
the network?

When completed, you will have downloaded
the hardware configuration to the stations.

If you start with the existing sample configuration, you 'TIP \
should get an overview of it before you download the - Page 19 deals with the topic 1
configuration to the PLC. STEP 7 provides you with _‘Downloading”
convenient methods of obtaining an overview. You can

do the following:

1

¢ Display the configuration in HW Config For more infor- Manual
¢ Display a station overview mation... el
¢ Display the networking of the stations graphically with Volume 1

NetPro

Chapter 2

» Double-click the object “PROFIBUS(1)” in your project

in the SIMATIC Manager. This opens the view for your  BHOFIEUS T

project.

%NE[FID - [PROJECT-PROFIBUS [Network] -- D:\Siemens\Step/\Examples\expb]
%g Metwork  Edit Inset PLC Yiew Options Window Help _|E‘ LI
2@ (% S| | sl 8] o[L] B %]
=
PROFIBUS (1)
FROFIBUS
|FMS—CI\Bnt ST 400-Stat. |SIMATIC 300 DP-Master SIMATIC 300-Station(1)
i 1R [ 5 o5 Gl
Bk
o = [= ]
FEE ‘ 2 10
|FMS—SEN8r S7 400-Stat SIMATIC 300 DP-Slave SIMATIC 300-Station(2)
[T R m 5
=] Il.aslc (@ E (m
2 16 2 12 2 B
4 | L4
Local I Partnet 10 Partnet Type Active connection partner j
pO0T_&000 000 -
|

From this display, you can start all the steps required for hardware and connection
configuration.

SIMATIC NET NCM S7 for PROFIBUS
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“PROJECT PROFIBUS”

As shown in the illustration:

¢ The connection table for the selected CPU is displayed in the lower part of the screen.

Information about the network attachment is displayed if you point to the symbol for the
interface of the node with the mouse pointer.

You can recognize the following situation:

The CP 342-5 is shown with a PROFIBUS address and an MPI address. You require the MPI

address, for example, when you want to obtain diagnostic information about the CP via the MPI
attachment of the CPU with NCM PROFIBUS diagnostics.

Only the MPI address is shown for the CPU.

If you want to modify the network address... {_or more infoyma-

on...
... you can call the Properties dialog of the PROFIBUS o Manual
node. You obtain this dialog by double-clicking the 12/
network node in the view. An address change may, for
example, be necessary when the configured PROFIBUS Volume 1
address in your network is already being used by another Section
station. 224 -

Displaying the configuration in HW Config — here based on the example of the
SIMATIC 300 station(1)

»~ Select the SIMATIC 300 station(1) in the view; then select Edit » Open Object. You will see
the hardware configuration.

E{; H% Config - [SIMATIC 300-5tation[1) [Configuration] -- PROJECT-PROFIBUS]

Eﬂ] Station Edit Inset PLC ‘“iew Options *indow Help

- 5]
Dle-2 (% & fle] k| [@o] %2 sl
= (0] UR :IErofiIe IStandard j
1 i PS5 307 54
5 TR0 4T =20 FROFIELS DP
3 22 PROFIEUS-PA
4 DI/D 1Ex24V/0.58 SIMATIC 300
i TP 342601 SIMATIC 400
b SIMATIC PC Based Control 300/400
- -8, SIMATIC PC Station
< |
“=|o v
Slot fodule Order number Firmware WPl address lad.. | Q.. | C.. I
1] Fas0iga BES7 a07-1EADD-0AAD
2 [[8] cPu 31401 BES7 314-1AED4-0AB0 /1.2 2
3
4 |[] DI/0 T6x24v/0.58 BES7 323-1BLO0-0840 0.1 [o.a
5 |dik CP 342501 BGK7 3426DA02-KED V5.0 3 272, 28372,
6
7
8
E] L_____] I D I
T » You require the module start address later when T %,
i + you program the SEND/RECEIVE interface. I
VTIP )
Press F1 to gat Help » The hexadecimal representation required in the =
: )
1
1

user program can be seen in the “Properties FDL :—
Connections” dialog, see Page 27.

SIMATIC NET NCM S7 for PROFIBUS
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“PROJECT PROFIBUS”

If you want to see the configuration of one of the displayed modules in detail,

»~ Position the cursor on the module, for example the CP 342-5 and select Edit » Object
Properties.

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C113-03 15



“PROJECT PROFIBUS”

Adapting the configuration in HW Config

If your hardware configuration does not match the configuration required for the sample, you
can now change the entries. You could, for example, make the following changes:

¢ Move modules to different slots.

— The configuration of the connections is retained.

— User programs may have to be adapted to a new module address.

e Work without a simulation module

To do this, delete the simulation module in slot 4.

¢ Use a different CP type

Outputting a station overview

Use the print functions of STEP 7 to create your system documentation. You can print out the
following documentation from the HW Config:

e Entire station

e Selected module(s)

The printout for the CP you select as the module then appears as shown below (example):

SIMATIC

PROJECT-PROFIBUS/SIMATIC 300-Station(l)

09/13/2002 15:39:21

Rack 0, Slot 5
Short designation:
Order no.:
Designation:

Location
Station:
Width:

MPI address:

Network
Network type:
Network name:
Network address:

Addresses
Inputs
Start:
End:
System selection:
Outputs
Start:
End:
System selection:

Comment :

16

Name of MPI network:

CP 342-5

6GK7 342~-5DA02-0XEO

CP 342-5(1)

SIMATIC 300-Station(l)
1

PROFIBUS
PROFIBUS (1)
2

272

272
16

\/\/\/

SIMATIC NET NCM S7 for PROFIBUS
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“PROJECT PROFIBUS”

Further information about networking the station

It is easy to obtain an overview of the existing network attachment configurations using the print
functions in .

The printout for a configured network appears as shown in the example below:

SIMATIC D:'=siemensy3TEP7V402Y Examp les' EXPR 03/24/1998 13:08:34

MPI (1) contains no network connections.

PROFIBUS (1) contains the following network connections:

Mode Address: Station: Module Rack: Slot:
2 SIMATIC CP 342-3 BGR{1)D ]
300-5tation(1) -
4 SIMATIC 58(1) - - -
5 SIMATIC CP 342-5 BGR(Z)0 ]
300-Station(2) -
8 SIMATIC CP 342-3 BGR(3)0 ]
300-5tation(3) -
10 SIMATIC 300 CP 342-3 BGR{5)0 ]
DP-Master -
12 SIMATIC 300 CP 342-5 BGR{4)D 1]
DP-Slave -
14 FMS-Cliert 57 CP 443-3 Basic(10 4
400-5tat. -
16 FMS-Server 57 CP 443-5 Basic(20 1]
400-5tat. -
\/\/ \/

SIMATIC NET NCM S7 for PROFIBUS
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“PROJECT PROFIBUS”

Checking the network settings: adapting the transmission rate and bus profile of the
stations

The transmission rate and bus profile must also match in the STEP 7 project and in the
databases of other stations configured outside PROJECT-PROFIBUS, for example the S5
station (Sample 2).

In the STEP 7 project, the transmission rate and bus profile are configured in the Properties
dialog of the PROFIBUS subnet.

»~ Simply double-click the bus cable represented in to open the Properties dialog for the
PROFIBUS network.

Properties - PROFIBUS E
General Metwork Settings |
. Options... |

Highest PROFIBLIS ] ; —

Address: |125 j [" Changs

Transmission B ate: 19.2 kbitds ;I
93.75 kbit/s
187.5 khit/s
500 kbit's

Profile: DP
Univerzal (DP/FMS) Bus Parameters... |
|Jzer-Defined
PROFIBUS (1) []

Bus Parameters |

[V Tum On Cyclic Distibution of the Bus Parameters

Tslat_lnit: I 3000 t_hit Tslat: 3000 ¢ bit
b an. Tzdr: I 9803: t_hit Tid2: 980 +_hit
Min. Tedr: I 1503: t_bit Trdy: 150 t_bit
Tset: I 2403: t_hit Tid1: 515 t_hit
Tqui I DE: t_hit Ttr I 179444 ¢ bit
= 1196 mz

Gap Factor: I 503: Thr 40820 t_bit
m = 272 mz

Retry Linnit: -
Responze Maonitoring

I 719568 t_hit

= 4797 mz

Fecalzulae |

SIMATIC NET NCM S7 for PROFIBUS
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“PROJECT PROFIBUS”

To download the hardware configuration to the PLC...

...follow the steps outlined below:

» Connect the PG to the MPI interface of the CPU using the MPI cable.
~ Set the interface on your PG/PC for the required type of attachment.

»~ Select the PG/PC interface in the Windows control panel to match the CPs available on your
PG and to match the bus attachment.

' To check which nodes can be
 accessed via MPI, use the
' “Accessible Nodes” function.

In the sample project, the following is

+ displayed:
| MPI=2(direct) —> applies to CPU
 MP1=3 —> applies to CP

»~ Select the menu option PLC »Download.

STEP 7 then guides you through further dialog boxes to
the required result.

Manual
12/

Volume 1
Section
2.2.8

Summary of Step 2 “Configuring and Networking Your Hardware”:

You have now done the following

1. Configured the S7 stations in the STEP 7 project

2. Assigned the S7 stations to the PROFIBUS subnet and assigned addresses
3. Downloaded the configuration to both S7 stations.

The stations are now ready for you to configure the communication connections and
download the user programs.

4

SIMATIC NET NCM S7 for PROFIBUS
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3 Communication on the SEND/RECEIVE
Interface Between S7 Stations

The SEND/RECEIVE interface allows data exchange on configured
FDL connections.

This chapter explains the steps required during configuration and
programming to implement a simple communication task on FDL
connections.

How the chapter will help you:

¢ You will get to know the steps involved in configuration.
You will learn about downloading and starting up.

You will become familiar with the SEND/RECEIVE call interface.

You can use the sample program as a template for creating PLC

programs.

Requirements:

A working knowledge of STEP 7, experience with STL, a
basic knowledge of PLCs.

If you require detailed information about the properties of
the type of communication introduced here or about other
functions provided by the configuration software, please
refer to the corresponding manuals. The preface of the
manuals provides you with an overview of the available
documentation. This chapter also contains references to
specific manuals.

X Contents:
3.1 The task 21
3.2 System configuration 22
3.3 The example step-by-step 24

— Configuring FDL connections 25
— Creating the user program 31
— Startup/diagnostics 38

SIMATIC NET NCM S7 for PROFIBUS
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Communication on the SEND/RECEIVE Interface Between S7 Stations

3.1 The Task

Sending and receiving data
The communication task illustrated by the sample program has deliberately been kept simple.
e A controller (SIMATIC 300 Station(1)) processes process data.

¢ |t communicates with a further device (SIMATIC 300 Station(2)), for example to delegate a
control job. The server (SIMATIC 300 Station(2)) returns response data.

The following schematic illustrates how the program functions:

SIMATIC 300 SIMATIC 300
Station(1) Station(2)

T .
Process data
processing

Send job data (4 bytes) -

Accept and process job

< Send response data (4 bytes)

Evaluate received data

Time v Time

The job and response data to be transmitted in the sample task are all 4 bytes long.

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C113-03 21



Communication on the SEND/RECEIVE Interface Between S7 Stations

3.2 System Configuration

Structure

The following system configuration is required for the supplied sample project
(modifications/alternatives are possible — > see following page):

S7-300 Station 1 S7-300 Station 2
PS CPU314 SIM CP 342-5 PS CPU314 SIM CP 342-5
] D= | ] D= |
7 E I 7 E I
MPI interface
MPI interface

\ i
PROFIBUS
'
'
| i f
— =

PG/PC with STEP 7

SIMATIC NET NCM S7 for PROFIBUS
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Communication on the SEND/RECEIVE Interface Between S7 Stations

Required devices/resources

You require the following components if you want to use the example unmodified.

No. Type Order Number:
Required
2 S7-300 programmable controller with a CPU 314 See catalog ST 70
2 CP 342-5 6 GK7 342-5DA02-0XE0 1)
2 DI/DO simulation modules 6 ES7 323-1BL0O0-0AA0
1 Transmission path See [7/
1 Programming device (PG/PC) with see Catalog ST 70

* STEP 7 software, Version V5.2 or higher installed

* NCM S7 for PROFIBUS optional software Version
V5.2 or higher installed or with NetPro optional
software.

* MPI attachment

* As an option for the PG/PC mode on PROFIBUS: CP
for PROFIBUS attachment —>
diagnostics/installation/service

1) Newer versions of the module are normally compatible in terms of functionality; You can load

the configuration data of the sample project on your module without needing to make changes.
Please read the information in the manual of the CPs on the topic of compatibility and replacing
devices!

Alternatives:

You can adapt the sample configuration to your own situation. Possible modifications include
the following:

S7-400 instead of S7-300

Instead of S7-300 stations, you can also use S7-400 stations. In this case, you then use, for
example, the CP 443-5.

The appropriate modifications must then be made when configuring the hardware.
Using a different CPU type
Doing without simulation modules

This only requires a slight modification in the user programs so that there is no output to the
simulation module. Addresses must also be adapted (CP configuration). It is then possible to
monitor the communication by displaying the data blocks on the PG.

Using other input/output modules
This may mean that module addresses are changed.
Changing the order of the modules in the rack

With certain CPU types, this also changes the module address.

SIMATIC NET NCM S7 for PROFIBUS
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Communication on the SEND/RECEIVE Interface Between S7 Stations

Notice

If you change the module address in the configuration, you must also adapt the
user program and the configured connection.

3.3 The Example Step-by-Step

This description is based on the created project and on the configured stations. The steps
“Create Project” and “Configuring and Networking Hardware” were explained in Chapter 2.

| 1. Create/open your project 1~

[ 2. Configure and network your hardware V- Chapter 2

| 3. Configure FDL connections \

| 4. Write your user program | Chapter 3.3 / and pages following
| 5. Startup \

To achieve success quickly...

If your system configuration corresponds to the configuration selected for the example, you can
download the sample data directly to the S7 stations in steps 3 and 4.

You will, however, learn more by working through TIP

the steps as outlined in this primer. ' Skip the functions that you
, already know.

: Chapter 2 deals with the topic of

SIMATIC NET NCM S7 for PROFIBUS
24 C79000-G8976-C113-03



Communication on the SEND/RECEIVE Interface Between S7 Stations

\ 1. Create/open your project

\ 2. Configure and network your hardware

o
V

3. Configure FDL connections

| 4. Write your user program \

| 5. Startup

Communication on the SEND/RECEIVE interface uses
configured FDL connections. The next step is therefore
to download the connection list to the station.

Which CPUs require communication
connections for which communication
tasks?

When completed, you will have

downloaded the connection
configuration to the stations.

First, however, you should get an overview of the sample configuration as follows:

¢ Check the configured connections in the connection

table in NetPro.

tion...

Checking the connections in the connection table

» Change back to the SIMATIC Manager and select the CPU in the required station.

For more informa-

P

Manual
12/
Volume 1

Chapter 6

QSIMATIC Manager - [PROJECT-PROFIBUS -- D:ASiemens\5tep7\Examples\expb]

£ File Edt Inset PLC Wiew

Optionz  Window  Help

Cilcal 25| e il

il o =g o e [« NaFiter>

7| 2=

=& PROJECT-PROFIBUS
o[ FMSClient 57 400-5tat

SIMATIC 300 DP-Slave
g SIMATIC 300-Station(1)
A5 RGN
fF CP 3425 BGR(1)

Bl SIMATIC 300-5tation[2)
B SIMATIC 300-Station(3)

Prezz F1 to get Help.

FhiS-Server 57 400-5tat,
SIMATIC 300 DP-Master

3

S7-Programn Werbindungen

[program]

SIMATIC NET NCM S7 for PROFIBUS

C79000-G8976-C11.3-03
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»~ Select the object “Connection” and then select Edit»
Open Object. The connection table is then displayed.

or

¥ Go directly to the NetPro view by selecting the network.

%NE[FID - [PROJECT-PROFIBUS [Metwork] -- D:\Siemens\Step7\E zamplesiexpb]
%gﬂetwork Edit Inset PLC Yiew Options Window Help

Pl Coecion

22 (% 8| o] dilil & 2] B! N

MPI(1)
WP

PROFIBUS (1)

FROFIBUS

FMS-Client 57 400-Stat.

I

|

‘S\MATIC 300 DP-Master

|

CRl

B

Bl
325

FMS-Server ST 400-Stat

all

N
Hi-1 |H3s
(51

<

2 18

2

10

SIMATIC 300 DP-Slave

CFU [P
4 [Jas

P )

L]

SIMATIC 300-Station(1)

Type: PROFIBUS]
Addrass: 2

SIMATIC 300-Station(2)

CRU [P
i |2

= |\
.

Local ID Fartner ID

FPartner

Type

Active connection partner

0001 000 0001 A000

SIMATIC 300-Station(2) £ CPU31401)

FDL connection

J

Subnet !
PROFIBUS (1) (PROFIBUS)

/

Here, you can select the
connection properties

The following situation is clear:

One FDL connection is currently configured to the
partner station SIMATIC 300 Station(2).

Further connections...

Here, you can select
“Change Partners".

' ...By selecting the stations, you

, stations in the project and the

. can obtain an overview of all the

...You can configure further connections to this or other partner stations in this overview.

» To insert a new connection in the connection list, select the menu command Insert »

Connection.

26
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If required, you can check other connection parameters as follows...

»~ Select the connection properties by double-clicking the connection in the connection table.

Properties - FDL connection [ %]
General | Addreszes I Dptionsl Owerview I Statuz Information I
r— Connection Endpaint — Block Parameters

0007 A000

Marne: GFDL-Verbindung-1 7¥/

VialP:  |CP-3426-(RB/55]

/ Boute... | 0001 is the connection ID

you use on the FC call
interface in the user
program.

AO000 is the ID for FDL
connections.

Local ID [hex):

/ Cancel Help

|

Here, you can give the connection a name
to suit your plant or process.

» Now switch to the “Addresses” tab.

Properties - FDL connection [ %]
General Addreszes |Dpti0ns| Duwervism I Status Information I

Describes the address parameters of the local endpaint of an
FDL-cornnection.

Local Remote
FROFIBUS 2 IE
address:
LSAP (2. 331 E - 13 =

Cancel | Help |

The information in the “Addresses” tab page for a connection between S7 stations within a
project does not normally need to be modified.

SIMATIC NET NCM S7 for PROFIBUS
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You can obtain further information about the status of the connection or the connection
configuration in the “Overview” tab page.

General I Addresses I Options ~ Owerview | Status Information | Ovverview | Status Information |
Connections :

Local ID I Conn. name I R/5 I Partner addressl Local LS.&PI Femc Femaote LS.&PI Operating mode: I Status
0007 4000 FDL-erbindung-1 05 E 14 18 Send/Recv [u]4

al | JL2 [ 1 I
™| Display connestionsaf &l BRI

Frint Configuration | Frririt | Frint Configuration | Frririt |
Cancel | Help | Cancel | Help |

If an “1” is entered in the “Local ID” field, this indicates further relevant information in the
“Status” field. Depending on the settings of the table header, this field may be hidden. Using the
arrow key, you can move the table horizontally.

In the case shown here, the connection is currently being edited.

28
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If you want to address a different communication partner...

V~ ...select the “Change Partners” dialog with the menu option Edit> Change Partners or
double-click the connection in the “Partner” column in the connection table.

E‘.!_%Netl’lo - [PROJECT-PROFIBUS [Network] -- D:ASiemens\Step7\Examples\expb]

%Qﬂetwnrk Edit Inset PLC Yiew Options Window Help

=8 (%) 8| o] | &8 o] Bl

WP (1)
MPI
PROFE Change Connection Partner [ %]
~ Partrer
Station; ATIC 300
SIMATIC 300-Station(1
m Iodule: | R =] ation(1)
—  Connection
Type: FOL connection
C 300 DP-Slave SIMATIC 300
Cance hew | ||

0001 2000

Fartner

SIMATIC 300-Station(2) F CPLUS1401])
2 —

FDL connection

Active connection partner

» If required, select a different connection partner in the “Station” field.

SIMATIC NET NCM S7 for PROFIBUS

C79000-G8976-C11.3-03
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To download the connection configuration to the PLC...
...follow the steps outlined below:

» If you have made changes in the connection configuration, save your changes with
Connection Table » Save.

V¥ Select the station in the connection table for which the MPI attachment exists.

V¥ Select the menu command PLC » Download.

1 During downloading you are as-

' ked whether you want to copy

. from RAM to ROM. If you want to
' protect the data from power outa-
. ges, answer this prompt with

» Close the connection table.

File  Edit Insert PLC

Manual
14/

Note

You can also download the connection configuration via a “PG on the PROFIBUS".
To do this, the hardware configuration must first be downloaded via MPI (node
initialization).

V¥ Attach the MPI to the second station.

»” Repeat Step 2 “Configuring/Networking Your Hardware” and Step 3 “Configuring FDL
Connections” for the second station if you want to make changes to the existing
configuration of the second station.

Summary of Step 3 “Configuring FDL Connections”:

You have now done the following:
1. Configured an FDL connection between two S7 stations
2. Downloaded the connection configuration to the two S7 stations

The stations are now ready for data exchange on the SEND/RECEIVE interface.

SIMATIC NET NCM S7 for PROFIBUS
30 C79000-G8976-C113-03



Communication on the SEND/RECEIVE Interface Between S7 Stations

\ 1. Create/open your project

— How is the SEND/RECEIVE interface
supplied with data?

— How are the status bits evaluated?
When completed, you will have
downloaded the user programs to the
stations.

\ 2. Configure and network your hardware

AR Y

| 3. Configure FDL connections

4. Write your user program

| 5. Startup

The tasks in the user program

The task described in Section 3.1 must now be converted to suitable programmable controller
programs.

To execute the programs or to download them to the S7 stations...

V¥~ ...select the container with the program blocks in the ' Paqe 37 . detailed 1
required SIMATIC 300 station in the ! in?gr?natigr?r:k?gsjst mgrgjpiita' © !
PROJECT'PROFIBUS : “Down|0ading”_ !

QSIMATIC Manager - [PROJECT-PROFIBUS -- D:ASiemens\5tep7\Examples\expb]
%Eile Edit Inzert PLC “iew Options ‘Window Help

o] = e R = N N [[<WoFiter> ~1%| ==
=) PROJECT-PROFIELIS

- [f FMS-Client 57 400-5tat it 1F it

G FMS-Server STA00StaL | gorerdaten [sys DB 0B100 FC5

- SIMATIC 300 DP-Master data)

-l SIMATIC 300 DP-Slave

- SIMATIC 300-Station(1]

5 cruam it iF r iF

| =7 57-Frogramm [prc FCE FCz3 FC30 FC3

..... (B Quellen [zoun

Tk B aListeine (bls

- CP 3425 BGR(1) F
o[l SIMATIC 300 Station(2)
-l SIMATIC 300-Gtation[3] sFCz2
1] | H

Prezz F1 to get Help.

For a better overview...

»~ ...you should print out the program blocks and check them. The following page contains an
overview of the FCs required for communication.

SIMATIC NET NCM S7 for PROFIBUS
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The table shows which program blocks of the types OB and FC handle which tasks.

Task in S7 Station 1

Task in S7 Station 2

Description of the Task in the Program Blocks

Processing process
data

Simulation of a changing process value:

OB100

Provides data blocks DB30 and DB31. The process
values are saved in these data blocks.

OB1

Coordinates the program sequence.

FC29

A data word is incremented and decremented cyclically.
The time interval for both incrementing and decrementing
is 3 seconds.

FC30/ FC5 (AG_SEND)

The data word is transferred to Station 2 as the current
process value (job).

Accept and process
job

Accepting and further processing the job data:

OB100

Provides data blocks DB30 and DB31. The process
values are saved in these data blocks.

OB1

Coordinates the program sequence.

FC31/FC6 (AG_RECV)

Saves the received data in the data block and outputs the
data to the process simulation.

FC30/ FC5 (AG_SEND)
Return the data to Station 1 as job confirmation.

Evaluate the receive
data

FC31/FC6 (AG_RECV)
Accepts and evaluates job confirmation.

Outputs process data to the simulation module.

Notice

You can take and use the latest versions of the communications blocks (FC5/
FC6) for your module from the SIMATIC NET block library of STEP 7.

If you are using an older module type, this is only possible if you use the latest
firmware version for this module type.

32
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The program sequence

The organization blocks in the example produce the following program sequence in the two S7

stations:

SIMATIC 300 Station(1)

\

0OB100

— Generate data
blocks DB30
and DB31

\

OB1

A v FC29

— Increment
decrement /
data word

FC30

AG_SEND

FC31

AG_RECV

A LY

Startup

Cyclic
execution

FDL
connection

Legend: > Sequence of the CPU cycle

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C11.3-03

SIMATIC 300 Station(2)

v

0OB100

— Generate data
blocks DB30
and DB31

\/

OB1

FC31

AG_RECV

FC30

AG_SEND

33
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Programming functions (FCs) for communication

Two functions (FCs) are available for handling communication on the FDL connections, as

follows:

« AG_SEND (FC5)

This block transfers the user data from the specified  tion...

user data area to the PROFIBUS CP for transmission. . /I\g;amual

e AG_RECV (FC6) Volume 1
This block enters the received user data in the user
data area specified in the call. Section 7.3

For more informa-

The user program in our example was written in STL notation. As an example, the parameter
assignment for calling AG_SEND and AG_RECYV in the SIMATIC 300 Station(1) (client) is

shown below.

STL Expl anati on
call fc 5 /1 AG_SEND bl ock call
ACT 1= M 50.0 //Bit for triggering job
ID = 1 /I Connection I D
LADDR = WE16#0110 /| =LADDR 272pec. in hardware configuration
SEND = P#db30. dbx1.0 byte 240, //Data area to be transferred
LEN = 4 /1 Length of the data area to be sent (4 bytes
DONE = M1 2 /1 Memory bit for return parameter DONE
ERROR = M1.3 /1 Mermory bit for return paranmeter ERROR
STATUS : = MWV 200 /1 Mermory word for return parameter STATUS
STL Expl anati on
call fc 6 /1 AG_RECV bl ock call

/1
ID = 1 /I Connection I D
LADDR = WE16#0110 /1 Modul e address 512pgc. in hardware
RECV = P#DB31. DBX 1.0 BYTE 240 configuration

//Data area for receive data
NDR = ML. O /1 Mermory bit for return paranmeter NDR
ERROR = ML. 1 /1 Mermory bit for return paranmeter ERROR
STATUS : = MA202 /1 Memory word for return parameter STATUS
LEN = MALO /1l Area for length of receive data

For the complete code contained in these FCs and other OBs and FCs, please refer to the
printouts of the sample project.

34
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Setting Block Parameters Automatically

To ensure correct parameter settings for the block calls, The LAD/STL/FBD editor in STEP 7
provides you with the option of accepting all the relevant parameters from the hardware
configuration (HW Config) and from the connection configuration.

When assigning the parameters for the block in the user program, follow the steps outlined
below:

~ Select the block call and its block parameters;
»~ Select the menu command “Connections...” with the right mouse button.

»~ Depending on the block type, you can now select the connection intended for the block or
module from a list.

»~ Confirm your selection; as far as possible, the available parameter values are entered in the
block call.

Extending the sample program

You can also extend the sample program or later your own applications by including further
functions such as the following:

¢ Evaluation of the result codes of the FCs AG_SEND and AG_RECYV to allow you to react to
specific statuses or errors.

e Conditional initiation of communication calls depending on result codes, so that, for example,
the send call on the client is only triggered again after the job confirmation has been
received with the receive call.

»~ Evaluate the parameters DONE, ERROR and For more detqils —_—
STATUS for AG_SEND and NDR, ERROR and about return v Manual
STATUS for AG_RECV. You evaluate these ' N 12/
parameters as shown below:

Volume 1

Section 7.3

SIMATIC NET NCM S7 for PROFIBUS
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Job
DONE/NDR =1 DONE/NDR =0
ERROR =0 ERROR =0
STATUS =0 STATUS =n
Completed without error Active

where n =

8302y Job active

8181y There are no
received data

Example without a simulation module

DONE/NDR =0
ERROR =1
STATUS =x

Terminated with error

Typical error codes (STATUS) that
must be handled by the user program:

8302y Lack of resources on partner

8311y Destination station not (yet) obtainable
(e.g. due to startup)

80C3y Resources occupied (due to maximum
load on S7 400)

80D2y Module start address incorrect
(e.g. you forgot to change the address
after moving a module).

If you do not want to use simulation modules, simply deactivate the output “T QW ..."” in the

FC31 blocks on SIMATIC 300 Station(1) and 2.

You can then follow the execution of the program by displaying the data blocks online in

STEP 7/STL.

36

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C11.3-03



Communication on the SEND/RECEIVE Interface Between S7 Stations

To download the user program to the PLC...

...follow the steps outlined below:

» Change the CPU to STOP or RUN-P.

»~ Select the “Blocks” container in the appropriate station in the SIMATIC Manager.

» Download the entire program (apart from the STB) using the menu command PLC»
Download.

" In the RUN-P mode, the block or-
' der is important since the CPU cy- .
' cle is active. Make sure that

. OB100 is only executed during

' startup.

» Change the CPU to RUN-P or RUN. For more informa-

Manual
14/

»” Repeat the download procedure for the other station.

Summary of Step 4 “Creating the User Program”:

You have now done the following:

1. Created user programs according to the task description for both S7 stations
2. Extended the sample programs, for example by evaluating the status codes
3. Downloaded user programs to the CPUs at both S7 stations

Result:

If you are working with simulation modules, you should now see the active LED displays on
the simulation modules.

If you cannot detect any communication, do one of the following:

»~ Check the program sequence online in STEP 7/STL. Check whether a changing data word
is being output to the simulation module.

» Go on to the next step and check communicaiton with PROFIBUS diagnostics.

SIMATIC NET NCM S7 for PROFIBUS
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\ 1. Create/open your project

Using PROFIBUS
diagnostics you can detect
communication problems.

| 3. Configure FDL connections

L~
| 2. Configure and network your hardware L
L~
V

\ 4. Write the user program

5. Startup — Diagnostics

»~ Use, for example, the following diagnostic functions

to, check the status of the stations and FDL For more infoyma- e
connections. tion...
~ Manual
12/
Volume 1
¢ PROFIBUS Nodes Chapter 8

Were FDL connections established?
What is the status of the stations?

¢ Diagnostic Buffer
What do the diagnostic buffer entries say?
* FDL

What is the status of the FDL connections?
Were frames sent?

How many successful?

How many with errors?

SIMATIC NET NCM S7 for PROFIBUS
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4 Communication on the SEND/RECEIVE
Interface between S7 and S5 Stations

In the first example we showed you the steps involved in configuring
and programming to implement a simple communication task with FDL
connections.

In this chapter, we will now show you the (slight) differences that arise if
you want to communicate with a “non-S7” station. These stations are
generally known as “Other Stations”.

The communication task in this chapter remains the same as in
the first example. The only change is the system configuration
in which an S7 station is replaced by an S5 station.

Based on Chapter 1, you will learn the following:
¢ How to handle “Non-S7 Stations” in the STEP 7 project

¢ How to handle STL connections to “Non-S7 Stations”

Requirements:

Working knowledge of STEP 7, knowledge of STL, basic
knowledge of programmable controllers, a working
knowledge of SIMATIC S5.

Contents:
4.1 Changed System Configuration 40
4.2 The Example Step-by-Step 42
— Creating your project 43
— Configuring/networking your hardware 44
— Configuring FDL connections a7
. — Creating the user program 49

SIMATIC NET NCM S7 for PROFIBUS
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4.1 System Configuration

In the system configuration shown in Section 3.2, the S7 station 2 is replaced by a SIMATIC S5
station (modifications/alternatives are possible —> see Section 3.2):

SIMATIC 300 Station (3)

SIMATIC S5
CPU314 SIM CP342-5  with CP 5430/31 | \Dﬂ =
= == A [ONO]O [0 N
H — H 0 0 N
2 = gD ~
— |
MPI
interface
—a

—

oI RE TR

j‘ﬁg

PG/PC with STEP 7

Required devices/resources

You require the following components if you want to use the supplied example unmodified.

No. Type Order Number
Required
1 SIMATIC S7-300 programmable controller See catalog ST 70
1 CP 342-5 DP 6 GK 7342-5DA02—-0XE0 1)
1 DI/DO simulation module 6 ES 7323-1BL0O0-0AA0
1 SIMATIC S5 programmable controller See catalog ST 52.3, ST 54.1
1 CP 5431 6 GK1 543-1AA01

1) Newer versions of the module are normally compatible in terms of functionality; You can load
the configuration data of the sample project on your module without needing to make changes.
Please read the information in the manual of the CPs on the topic of compatibility and replacing
devices!

SIMATIC NET NCM S7 for PROFIBUS
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No. Type Order Number
Require
d
1 Transmission path See [7/
1 Programming device (PG/PC) with

STEP 7 V5.2 or higher software installed

NCM S7 for PROFIBUS version V5.2 or higher
optional software installed .

STEP 5 and NCM COM 5430/5431 software installed
MPI attachment

As an option for the PG/PC mode on PROFIBUS: CP
for PROFIBUS attachment —>
diagnostic/installation/service

On the S5 station you can use the sample program supplied with the NCM COM 5430/5431
configuration tool. Depending on the hardware configuration (CPU type etc.), you must select
the suitable sample programs. For more detailed information refer to

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C11.3-03

1
Manual
111/

Section 7.3
Chapter 16
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4.2 The Example Step-by-Step

The following example is based on the project that was created and the stations that have been
configured. The steps “Creating your project” and “Configuring/networking your hardware” were

explained in Chapter 2.

| 1. Create your project [

| 3. Configure FDL connections

| 4. Create your user program

| 2. Configure and network your hardware V-
|
|
|

| 5. Startup

To achieve success quickly...

1

Chapter 2

Section 4.2 / and pages following

If you system configuration corresponds to the configuration selected for the example, you can
download the sample data directly to the S7 stations in steps 3 and 4.

You will, however, learn more by working through
the steps as outlined in this primer.

42

' Skip the functions that you al-
 ready know.

: Chapter 2 deals with the topic of
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1. Create your project

2. Configure and network your hardware Extra:

3. Configure FDL connections The S5 station is managed

with NCM COM 5431.

\ 4. Create the user program

5. Startup — Diagnostics

Managing the S7 station:

You use the database file for the sample program for the CP 5431 and edit this with the COM
5431 configuration tool.

Configuration
environment for
SIMATIC S5 with CP 5430/31

NCM COM 5431 For more information, refer to:
P
Database file: QAGAG.xxx - Manual
111/
Section 7.3
Chapter 16

Summary of Step 1 “Creating your Project”:

1. You have created a project in STEP 7 in which you can configure your S7 station and
save the corresponding user programs.

2. You have created a database file for the S5 station in which the CP configuration
data can be saved.

SIMATIC NET NCM S7 for PROFIBUS
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| 1. Create your project e

Extra:

2. Configure and network your hardware ) ] )
The S5 station must be included in the

STEP 7 project and networked.

— The PROFIBUS addresses and the
bus parameters of the S5 and S7
PLCs must be matched.

| 3. Configure FDL connections \

| 4. Create the user program \

| 5. Startup \

To configure the S7 station in the STEP 7 project...

...follow the procedure described in Chapter 2.

Managing the S5 station:

For information about managing configuration data and the (sample) programs, please refer to
This provides you with information about handling

P
the S5 tools. R Manual
111/
Chapter 16
To network the S7 station with the S5 stationand to be able to obtain -

the station on FDL connections...

...this “S5 station” must be included in the STEP 7 project. In the sample project, a station of
the type “SIMATIC S5” has been created.

QSIMATIC Manager - [PROJECT-PROFIBUS -- D:ASiemens\5tep7\Examples\expb]

%Eile Edit Inzert PLC “iew Options ‘Window Help

Cil 825 [ =[] sl [= = 2. =

[ Ho Fiter > =1¥| 38ls

=& ; ; ; ;
FMS-Cliert 57 400-Stat = - 2 -
FM3-Server 57 400-5tat FMS-Clisrt 57 FMS-Server 57 SIMATIC 300 SIMATIC 300
SIMATIC 300 DP-taster 400-5at. 400-5tat. DP-Master DP-Slave
SIMATIC 300 DP-Slave
SIMATIC 300-Station{1] 5 ; ; —T
SIMATIC 300-5tation[2] L | L | » |
EHER SIMATIC 300-Station(3] SIMATIC SIMATIC SIMATIC SIMATIC 55(1)
300-5tation(1] 300-5tation(2) 300-5tation(3]
MPI [1] PROFIBUS (1)

Prezz F1 to get Help. | | |

If you want to continue working in another project, you must now create a “SIMATIC S5 station”.

»~ Select your project.
V” Select the Insert »Station »SIMATIC S5 menu command.

SIMATIC NET NCM S7 for PROFIBUS
44 C79000-G8976-C113-03



Communication on the SEND/RECEIVE Interface between S7 and S5 Stations

...Now network the station

Networking the S7 station is also the same as in the first example. The main point of interest
here is how to network the SIMATIC S5 station.

3. Select the S5 station in your project using the
SIMATIC Manager.

4. Select the Object Properties dialog with the menu option Edit »Object Properties or by
double clicking the button in the toolbar.

5. Switch to the “Nodes” tabbed page.

Properties -SIMATIC 55 [ %]

General [nterfaces |

Marme Type Addrezz Subret

PROFIEUS Teilnehmer (1] PROFIBUS interface 4 PROFIEUS (1]

» To check which
PROFIBUS address
the S5 station is
accessed with, select
the PROFIBUS station
and click the

“Properties” button.

Meva... ioPopEr mo F'arametersl

Address: IE! i I

Highest addres=:126

Transmission rate: 1.5 Mbit/s

Subnet:

--- ot networked - Mew. .

Froperties... |
Delete |

FROFIBUS [1] 1.5 Mbit'z

Matching the transmission rate and bus profiles of the stations

You must also configure a matching transmission rate and bus profile in the STEP 7 project and
in the database for the PROFIBUS CP of the S5 station.

In the STEP 7 project, the transmission rate (baud rate) and the bus profile are configured in
the properties dialog of the PROFIBUS subnet.

»” Check the settings as described in Chapter 2.

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C113-03 45



Communication on the SEND/RECEIVE Interface between S7 and S5 Stations

Networking station 2 (S5) in COM 5431

You must adapt the following parameters in the network
configuration of the S5 station:

» Select a matching transmission rate. In the sample
configuration, 1.5 Mbps are set for the PROFIBUS
network.

»” Select a matching PROFIBUS address. In the sample
configuration, the address “4” is set for the S5 station.

V¥ Specify that you want to modify the network data
globally and then match the network using the
network file AGAGQNCM.NET before you download
the configuration data to the S5 station.

Downloading the hardware configuration to the PLC

~

r':
Manual
111/

Chapter 16

To download the configuration data to the S7 station, follow the steps outlined bel

e For the S7 station, as described in Chapter 2.

e For the S5 station as described in

Summary of Step 2 “Configuring and Networking Your Hardware”:

You have now done the following:

1. Configured the S7 station in the STEP 7 project

2. Assigned the S7 station to the PROFIBUS subnet and assigned addresses

3. Downloaded the configuration to the S7 station

4. Adapted the network configuration of the S5 station with NCM COM 5430/5431

The S7 station is now ready for you to configure communication connections and

download user programs.

46
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| 1. Create your project L~
| 2. Configure and network your hardware V-

3. Configure FDL connections

Extra:

The connection parameters for the
S5 and S7 PLCs must be
matched.

| 4. Create the user program \
| 5. Startup \

To create the FDL connections for S7-Station(3) in the STEP 7 project...
...follow the steps as described in the first example:
¢ Display the configured connections in the connection table

¢ Download the configured connections to the PLC

Checking/configuring connection parameters

In the Addresses tabbed page, adapt the LSAP setting so that it matches the configuration in
S5-Station. Only then can the local endpoints of the connection be correctly identified so that a
connection can be established successfully.

» Open the connection table for the CPU in the S7 station
»~ Select the connection properties by double clicking the connection in the connection table.
»” Change to the “Addresses” tab.

%NE[FID - [PROJECT-PROFIBUS [Metwork] -- D:\Siemens\Step/AExamples\expb]
%gﬂetwork Edit Inset PLC Yiew Options Window Help _|E‘ LI
2B (% &| || | 8] o]L] Bl x|
MPI (1) 2
P
=1 Properties - FDL connection B
ﬂ General Addresses IDmions' Overview | Status Information |
Describes the address parameters of the local endpoint of an
FDL-conhection.
Local Remote -Master SIMATIC 300-Station(1)
FROFIBLIS 2 B Fil . il
address:
L54P (2. 33} 5 EIES 2
2z
SIMATIC 200 DP-Slave SIMATIC 300-Station(2)
FE iR
3 |uzs EITN ETER]
m = H |E
| L
0| | »
Local I Partner ID Partner Type Active connection partner ‘Subnet a
| 0001 A000 (21 7 CPUST41) FDL connection 5 0 5 (11 (PRO =
|

»~ Check the LSAP entries and, if necessary, adapt the entries to the configuration of the S5
station.

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C113-03 47



Communication on the SEND/RECEIVE Interface between S7 and S5 Stations

To create or adapt the FDL connections for the S5 station...
...you must make sure that the connection configuration is suitably adapted.

»” Use the “Connection Editor FDL Connections” to adapt the connection endpoints SSAP and
DSAP so that the following applies:

SSAP (S5) = LSAP remote (S7) - hl/llfir/lual
DSAP (S5) = LSAP local (S7)

Chapter 7
In the example, the value “5” was selected for both LSAPs.

COM 5430/5431
connection edito
SSAP =5

FDL connection

perties - FDL connection

General Addreszes Detions | Owerview Statuz Information

DSAP =5 Describes the address parameters of H
FDL-cornnection.

& local endpoint of an

PROFIBUS 2
address:

LSAP[2... 33} |E -| m

Cancel Help

Downloading the connection configuration to the PLC
To download the configuration data to the S7 station, follow the steps outlined below:
e For the S7 station, as described in Chapter 2.

e For the S5 station, as described in...  ——

Manual
111/

Chapter 16

Summary of Step 3 “Configuring FDL Connections”:

You have now done the following:

1. Configured an FDL connection on the S5: (FDL connection) between the S7 station
and the S5 station.

2. Downloaded the connection configuration to both stations.

The stations are now ready for data exchange on the SEND/RECEIVE interface.

SIMATIC NET NCM S7 for PROFIBUS
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| 1. Create your project

Extra:

— OBs, FBs and HDBs are used at
the S5 end

L~
| 2. Configure and network your hardware V-
A/

| 3. Configure FDL connections

4. Create the user program
| 5. Startup \

The tasks in the user program

The table shows you not only the now familiar blocks in the S7 Station, but also blocks of the
type OB and FB in the S5 Station. These blocks are responsible for receiving job data from the
S7 Station and processing it.

Task in the S7 Task in the S5 Description of the Task in Program Blocks
Station Station
Processing process Simulation of a changing process value:
data OB100

Provides the data block DB 31. The process values are
saved in this data block.

OB1

Coordinates program execution.

FC29

A data word is incremented and decremented cyclically.
The time interval for both incrementing and decrementing
is 3 seconds.

FC30/ FC5 (AG_SEND)

This data word is transferred to Station 2 as the current
process value (job).

Receive and process | Receiving and processing job data:

job OB1

Coordinates the program sequence.

FB101 (HDB-RECEIVE)

Saves received data in the data block and outputs it to the
process simulation.

FB10 (HDB-SEND)
Returns data as job confirmation to Station 1.

Evaluate the receive FC31/FC6 (AG_RECV)
data Accepts and evaluates job confirmation:

Outputs process data to the simulation module.

Notice

You can take and use the latest versions of the communications blocks (FC5/
FC6) for your module from the SIMATIC NET block library of STEP 7.

If you are using an older module type, this is only possible if you use the latest
firmware version for this module type.

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C113-03 49



Communication on the SEND/RECEIVE Interface between S7 and S5 Stations

The program sequence

In the example, the OB blocks organize the following program sequence in the two stations:

S7 Station S5 Station
v 0OB20/21/22 v
OB100 FB111
— Generate data Startu _
blocks DB30 P IBIESSYNG
and
DB31
= _ \/
Cyclic
OB1 execution OB1
‘ ' FC29 A
— Increment /
decrement data word
FB101 v
| [
FC30 HDB-CTRL
AG_SEND FDL HDB-RECEIVE
connection 1
[ Feat FB10 I
AG_RECV HDB-CTRL
[
‘ —' ‘ HDB-SEND v A
—— |
Legend: > Sequence of the CPU cycle
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To process or download the programs of the S7 Station...

...follow the steps described in Chapter 2. The information in Chapter 2 about the program
extensions, for example to evaluate call status codes also applies here.

For the S5 Station...
...you should adapt the program to obtain the required sequence, as follows:

» In FB10, change the access in the HDB-SEND call from DB 20 to DB 22. This means that
the receive data are returned to the S7 station. This is indicated on the S7 station by the
LED display.

»~ If the CP 5431 is not synchronized during startup, this maybe caused by an incorrect OB20.
Copy the content of OB21 to OB20 so that the HDB-SYNC is correctly called.

Use the program file AGAGT2ST.S5D.

Notice

Make sure that you use the correct HDBs for the specific CPU in the S5 Station.
In the example, you require the following:

HDB-SYNC

HDB-CTRL

HDB-SEND

HDB-RECEIVE

Summary of Step 4 “Creating the User Program”:

You have now done the following:

1. Created user programs according to the task for both stations

2. Extended the sample programs, for example to include evaluation of status codes
3. Downloaded the user programs to the CPUs at both stations

Result:

If you are working with the simulation modules, you should now see the LED display
activated on the simulation modules.

»~ Check the program sequence in STEP 7/STL online (monitoring blocks). Follow the same
procedure with the programs of the SIMATIC S5 PLC in STEP 5.

» Check the communication using NCM PROFIBUS diagnostics; refer to the first example.
U
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5 DP Mode on PROFIBUS
S7-300 as DP Master and DP Slave

PROFIBUS DP allows simple, successful data exchange with
distributed peripheral devices. Based on the example of a PROFIBUS
CP that allows a SIMATIC S7-300 to be operated both as a DP master
and as an “Intelligent” DP slave, this chapter explains how to configure
and program a DP master system with STEP 7.

How the chapter will help you:

¢ You will get to know the steps involved in configuration for the
DP mode

You will get to know the DP call interface for the DP master and
DP slaves

You can use the sample program as a basis for creating PLC
programs

Requirements:

A working knowledge of STEP 7, experience with STL,
experience of PLCs, a working knowledge of DP.

If you require detailed information about the properties of
the DP function introduced here or other functions
provided by the configuration software, please refer to
the corresponding manuals. The preface of the manuals
provides you with an overview of the available
documentation. This chapter also contains references to
specific manuals.

== Contents:
Va:

~ 5.1 The Task 53
5.2 System Configuration 54
5.3 The Example Step-by-Step 56
— Configuring the DP master mode 57
— Creating the user program 61
— Startup/diagnostics 67
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51 The Task

Sending and receiving data
As in the previous chapters, a simple communications task has been deliberately selected:
e A programmable controller (SIMATIC 300 DP master) processes process data.

e Data is output to an intelligent peripheral device (SIMATIC 300 DP slave) in which the
process data is further processed and output to the process. Process data read in by the DP
slave is returned to the DP master.

The following schematic illustrates this situation and how the user program functions.

SIMATIC 300 SIMATIC 300
DP master CP CP DP slave

= = =

Process data
processing

|
Write output data

- e
Prepare output data
4 AN Output data
( Read/writeDP ) o
N\ 7
Input data
-
Prepare input data
Read input data
-t
Evaluate received data

Time
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5.2 System Configuration

Structure

The following system configuration is required for the supplied sample project (modifications /

alternatives are possible — > see following page):

SIMATIC 300
DP master SIMATIC 300
PS  CPU314 SIM CP 3425 DPslave g cpusia sim cp3azs
{ o = I | { sl = 0
MPI interface
MPI interface

PROFIBUS

J

PG/PC with STEP 7

54
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Required devices/resources

You require the following components if you want to use the supplied sample unmodified

No. Type Order Number
Required
2 S7-300 programmable controller with the CPU 314 See catalog ST 70
2 CP 342-5 DP 6 GK 7342-5DA02-0XE0 1)
2 DI/DO simulation modules 6 ES 7323-1BL00-0AA0
1 Transmission path See [7/
1 Programming device (PG/PC) with See catalog ST 70

® STEP 7 V5.2 software or higher installed

® Optional software NCM S7 for PROFIBUS V5.2
installed.

* MPI attachment

* As an option for the PG/PC mode on PROFIBUS: CP
for PROFIBUS attachment —>
diagnostics/installation/service

1) Newer versions of the module are normally compatible in terms of functionality; You can load
the configuration data of the sample project on your module without needing to make changes.
Please read the information in the manual of the CPs on the topic of compatibility and replacing
devices!

Alternatives:

You can adapt the sample configuration to suit your own configuration. Possible modifications
are outlined below:

¢ Using a different CPU type
¢ Doing without simulation modules

This only requires a slight modification in the user programs so that there is no output to the
simulation module. It is then possible to monitor the communication by displaying the data
blocks on the programming device.

¢ Using other input/output modules
This may mean that module addresses are changed.
¢ Changing the order of the modules in the rack

With certain CPU types, this also changes the module address.

Notice

If you change the module address in the configuration, you must also adapt the
address in the block call of the user program.
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5.3 The Example Step-by-Step

The following description is based on the created project and the configured stations. The steps
“Create your project” and “Configure and network your hardware” were explained in Chapter 2.

| 1. Create your project 1~

| 3. Configure DP master system

| 4. Create your user program

| 2. Configure and network your hardware V-
|
|
|

| 5. Startup

To achieve success quickly...

?

Chapter 2

Section 5.3 / and pages following

If your system configuration corresponds to the configuration selected for the example, you can
download the sample data directly to the S7 stations in steps 3 and 4.

You will, however, learn more by working through
the steps as outlined in this primer.

56

' Skip the functions that you
| already know.

: Chapter 2 deals with the topic
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| 1. Create your project L~
| 2. Configure and network your hardware V-

3. Configure DP master system

How is a DP master system
created?

—  Which input and output

areas can the DP master
address using which DP
slaves?

| 4. Create the user program \

| 5. Startup \

The key to the configuration of a DP master system is setting the mode of the PROFIBUS CP.
More precisely, the modes are adopted by the CPs in the name of the stations.

Setting the DP mode based on the example of S7 stations “DP master” and “DP slave”
Follow the steps below to check or change the setting:

»~ Select the PROFIBUS CP in the configuration table of the S7 Station 2.

»~ Select Edit>Object Properties.

Properties - CP 342-5 - [RD/55] [ %]

General | Addresses  Operating Mode | Dptions | Diagnostics |

" NoDP

DP master

DF delay time [ms]: ID.D
Properties - CP 342-5 - [RD/55] [ %]

General | Addresses  Operating Mode | Dptions | Diagnostics |

 DP slave  NoDP
¥ | Tihe module s an active node ol ' DF master
f &ster: Sratiar : _
P [P el el bt e ] IU.D

Erach (F 2 elat 5]
Irtertacemodile s/t

DP mode: I 57-compatibl

¥ The module is an active node on the PROFIELS subnet

r azter: Station: Mat in project
M odule:
Fack [R] / slat [S):
Interface module slat:
DP slave
DE mode: IS?-compatible j
e 1 Pt T |

»~ If the operating mode has not already been set to DP slave automatically, click the DP slave
field.

” Repeat the procedure for the DP MASTER station and make sure that the DP master
operating mode is set.
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The function “Module is Active Node on PROFIBUS” must always be selected when
* You also want to operate FDL connections or S7 connections

* You require PG functions (for example diagnostics).

Assigning DP slaves and slave modules to the DP master

Once you have configured the hardware, you must inform the DP master of the configuration of
the connected DP slaves.

This is particularly simple when the DP slaves in the STEP 7 project are already configured and
networked.

First, however, you should get an overview of the sample configuration of the DP master
system:

» Open the hardware configuration of the S7 station for more detajled in- | —
that you want to function as the DP master. formation... Manual
From the DP master system attached to the CP, you N Gll 1
can see immediately that the CP 342-5 is configured olume
as the DP master. Section

541

@;:HW’ Config - [SIMATIC 200 DP-Master [Configuration] -- PROJECT-PROFIBUS]
E“] Station  Edit Ingeit PLC “iew Option: Window Help - |E|1|

D[ca-(® (%] S| mle] snlsal @] %) x|

[0) UR =
% P5307 104

CPU 31401)
PROFIBUS [1]: [180)

T

al12157-300

-
1| 3

oo [— | ]

= =1

] v

Slat Modula ... | Order number Firrmweare | MPI address | | address | @ address | Comment

1 | [ PS307104 EEST 307-1KADD-O4A0 -

2| |8 CPU314(1) BEST 34-1AED4-04B0 1.2 2

3

Z DO1ExDC24W /054  |BEST 322-1BHOT-04AD 0.1 b

5 HiF CP 342.5(5) EGETF 342-80A02-0E0 VB0 3 27228V |dve.2ET

E ~|
Fresz F1 to get Help. l—l_ o

For the DP slave, there is one universal module configured for data input and one for data
output each with a length of 10 bytes.

SIMATIC NET NCM S7 for PROFIBUS
58 C79000-G8976-C113-03



DP Mode on PROFIBUS

DP modules can be taken individually from the hardware configuration.

V~ First select the DP slave that has already been created; in the lower half of the screen, you
will then see the configuration table for the DP slave.

»~ Select the entry “PROFIBUS-DP/stations already configured/S7-300 CP342-5 DP” in the
hardware catalog. You will see the corresponding entries for universal modules that you can
drag, if required, to the configuration table.

E{a:HW Config - [SIMATIC 300 DP-Master (Configuration) - PROJECT-PROFIBUS]
Eﬂ] Station Edit Inset PLC “iew Options “indow Help - |ﬁ'|5|

D[E-R (% S| ®e sl [Mo] 8 x|
sl jEfo"E | Standard =l
1 PS5307 104
z % CPU 31401 [ FROFIELS DF =
-0 Additional Field Devices

poies0C24v0%5, 03 CiR-Objskt
7] Closed-Loop Controller

CP 342-5(5
o I=-{Z1 Configured Stations
----- B CPU s

PROFIBLIS (1): (180

----- E ETZ2005 / CPU

[]---2 PC station az DP Slave
=+ 57-300 CP 3425 DP

5] BGK7 342-6DA02-04ED

3
1
5
5
7
8
9
1
1

b
| | LI—I - [@ Universal moduls
-4 1byte Dl/canstey 1
3

4m|=)| (12) 57300 CP3425 0P .

Zbyte Dl fconstoy 1+
[l . &

Slat Bestellnurmer / Bezeichhung | Address 0 Address Corrnatit | {<|
1 25 |Universal module 0.9 ] =
2 41 |Universal module 0.9 ;I

Prezs F1 to get Help. Chg 2

Creating the DP master and DP slaves

In the sample configuration, you already have a DP master system. This section is a brief
explanation of how this configuration is achieved.

The initial requirement is that you have configured a PROFIBUS CP with master functionality
(CP 342-5 DP) in the station that you want to act as master. As an alternative, you could use a
CPU with integreated DP functionality.

By setting the mode of the PROFIBUS CP to DP master, you have already ensured that a
“hanger” ——==x=x=x=3 appeatrs in the configuration table for the configuration of the DP
master system.

If you now follow basically the same procedure and configure stations with PROFIBUS CPs as
DP slaves, make sure that these DP slaves are entered in the hardware catalog as shown
above.
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To download the hardware configuration to the PLC...

...follow the steps described in Chapter 2.

Summary of Step 3 “Configuring the DP Master System”:

You have now done the following

1. Configured the DP master system with the SIMATIC 300 DP slave as an “Intelligent”
DP slave in the STEP 7 project

2. Checked the operating modes of the station
3. Downloaded the configuration to the two S7 stations

The stations are now ready for you to download user programs.
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| 1. Create your project

— How is the FC interface
supplied with data?

— How are the status codes
evaluated?

\ 2. Configure and network your hardware

AN

| 3. Configure DP master system

4. Create the user program
| 5. Startup \

The tasks in the user program

The task described in Section 5.1 must now be converted to suitable PLC user programs.

To edit the programs or to download them to the S7 stations...

~ ...select the container containing the program blocks TIP

. . L . Page 66 deals with the topic of
in the required SIMATIC300 station in the ' “Downloading”.

PROJECT-PROFIBUS. T

QSIMATIC Manager - [PROJECT-PROFIBUS -- D:ASiemens\5tep7\Examples\expb]

%Eile Edit Inzert PLC “iew Options ‘Window Help

Dz (E7] ] % [2ele) il [2 2] [ o fi]mm

=& PROJECT-PROFIBUS

[« NaFiter> 7| B8

-l FMS-Client 57 400-5tat. 1r iF 1F
FMS-Server 57 400-Stat Systerndaten [sys 081 0B 00 FiC1
=l SIMATIC 300 DP-Master data)
=@ cPu3t4)
=+{z7] 57-Programm (program]
@ Quellen [sources) D j:l- D D
ine | FC2 FC3 FC4 FC29

=-4fF CF 3425 BGR(5)
E-E] SIMATIC 300 DP-Slave

- cruIan) iF
E|" S7-Prograrm [program)
(B Quellen [sources) SFC2z

----- {£H Bausteine [blocks)
-+ CP 3425 BGR(4)

-l SIMATIC 300-Statian(1)
E-F SIMATIC 300-Gtation(2]
- SIMATIC 300-Station(3)

Prezz F1 to get Help.

For a better overview...

»~ ...you should print the program blocks and check them carefully. An overview of how the
FCs are supplied with data for DP communication is shown on the following page.
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The table shows the program blocks of the type OB and FC and the tasks they handle.

Task in S7 Station 1

Task in S7 Station 2

Description of the Task in the Program Blocks

Processing process
data

Simulation of a changing process value:

OB100

Provides data blocks DB30 and DB31. The process
values are saved in these data blocks.

OB1

Coordinates the program sequence.

FC29

A data word is incremented and decremented cyclically.
The time interval for both incrementing and decrementing
is 3 seconds.

FC1 (DP_SEND)

This data word is transferred to Station 2 as the current
process value (job).

Receiving and
processing output
data and output to
the process

Receiving and processing output data:

OB100

Provides data blocks DB10 and DB11. The process
values are saved in these data blocks.

OB1

Coordinates the program sequence.

FC2 (DP_RECV)

Saves the received data in the data block and outputs the
data to the process simulation.

FC1 (DP_SEND)
Returns the data to Station 1 as job confirmation.

Evaluating the
receive data

FC2 (DP_RECV)
Receives and evaluates the input data sent by the
DP slave (process data):

Outputs process data to the simulation module.

Notice

You can take and use the latest versions of the communications blocks (FC5/
FC6) for your module from the SIMATIC NET block library of STEP 7.

If you are using an older module type, this is only possible if you use the latest
firmware version for this module type.
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The program sequence

The organization blocks in the example produce the following program sequence in the two S7
stations:

S7 station 1

S7 station 2
DP master DP slave
0OB100 OB100
— Generate data Startup — Generate data
blocks DB10 blocks DB10
andDB11 and DB11
x Cyclic
execution
OB1 ( OB1

A ¥ ' oeu ' bR A
DP_SEND %i> - DP_RECV J

FC29 / \
— Increment / < Read jwrite DP P4
decrement S 4
data word
1 DB10 ! 1 DB11 1
E DP_RECV %:: <5 DP_SEND ]

Legend: > Sequence of the CPU cycle
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Programming FC blocks for the DP mode

Two functions (FCs) are available for handling the DP mode, as follows:

e DP_SEND (FC1) for more detajled in-
This block transfers the data of a specified DP output formation... Manual
area to the PROFIBUS CP for output to the - /2]
distributed peripheral I/Os. Volume 1

e DP_RECV (FC2) Section 7.3
The block receives the process data of the distributed :
peripheral 1/0Os and status information in a specified -

DP input area.

The user program of our example was written in STL notation. The following examples show
the call parameter assignment for DP_SEND and DP_RECYV in the “Master” S7 Station (DP
master).

STL Expl anati on

call fc 1 /1 DP_SEND bl ock cal |

CPLADDR: = WE16#0110 /1 Modul e address 272pgc. in hardware config.
SEND = P#db11l. dbx0. 0 byte 10, //Data area to be transmitted (10 bytes)
DONE = M1 2 /1 Address for return paraneter DONE

ERROR = M1.3 /1l Address for return paraneter ERROR
STATUS : = MN 206 /1 Address for return paraneter STATUS

STL Expl anati on

call fc 2 /1 DP_RECV bl ock call

CPLADDR: = WE16#0110 /1 Modul e address 272pgc. in hardware config.
RECV 1= P#DB10. DBX 0.0 BYTE 10 //Data area for receive data (10 bytes)

NDR = ML. O /1 Address for return paraneter NDR

ERROR = ML. 1 /1l Address for return paraneter ERROR
STATUS : = MA200 /1 Address for return paraneter STATUS
DPSTATUS: = VB202 /1 Address for return paraneter DP-STATUS

For the complete coding of these FCs and other OBs and FCs, please refer to the printout of
the sample project.
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Extending the sample program

You can extend the sample program or later your own applications by including further functions
such as the following:

e Evaluation of the result codes of the FCs DP_SEND and DP_RECYV to allow you to react to
specific statuses or errors in your system.

e Use of the FCs DP_DIAG and DP_CTRL. With DP_DIAG, you can request diagnostic
information from the DP slaves. With DP_CTRL, you can send control jobs to the
PROFIBUS CP from within the user program.

»~ Evaluate the parameters DONE, ERROR and For more detailed —
STATUS for DP_SEND and NDR, ERROR and information about Manual
return values a anua
STATUS for DP_RECV. You evaluate these ECs 12/
parameters as shown below: N y Volume 1
Job Section 7.3

DONE/NDR =1 DONE/NDR =0 DONE/NDR =0

ERROR =0 ERROR =0 ERROR =1

STATUS =0 STATUS = 8180 STATUS =x
Completed without error Active Terminated with error

Typical codes (STATUS) that must
handled by the user program,
for example:

80D2yModule start address is incorrect (for
example you forgot to change the address
after moving a module)

Example without simulation module

If you do not want to use simulation modules, simply deactivate the output "T QW ..."” in the
FC31 blocks on the DP master and DP slave.

You can then follow the execution of the program by displaying the data blocks online in STEP
7/STL.
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To download the user programs to the PLC...

...follow the steps outlined in Chapter 2.

Summary of Step 4 "Creating the user program”:

You have now done the following:

1. Created user programs according to the task description for both DP master and
DP slave

2. Extended the sample programs, for example by evaluating the status codes
3. Downloaded the user programs to the CPUs of both S7 stations

Result:

If you are working with simulation modules, you should now see the active LED displays
on the simulation modules.

If you cannot detect any communication, do one of the following:

» Check the program sequence online in STEP 7/STL. Check whether a changing data word
is being output to the simulation module.

» Go on to the next step and check communication with PROFIBUS diagnostics.
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' 1.Create your project

\ 2. Configure and network your hardware

Using PROFIBUS diagnostics,

| 3. Configure FDL connections

you can detect communications

| 4. Create the user program

problems.

5. Startup — Diagnostics

¥~ Use, for example, the following diagnostic
functions to check the status of the stations and

the DP mode.
¢ PROFIBUS Nodes
Status of the stations?

¢ Diagnostic Buffer

What do the diagnostic buffer entries say?

e DP Master

for more detajled in-
formation...

P
Manual

N 12/

Volume 1

Chapter 8

What is the status of the DP master or DP master mode?

e DP Slave

What diagnostic data does the DP slave provide?
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6 Communication on FMS Connections

FMS connections allow the transfer of structured data between devices
that communicate on PROFIBUS and support the FMS standard.

This chapter explains the steps required during configuration and
programming to implement a simple communications task using FMS
connections.

How the chapter will help you:

¢ You will get to know the steps involved in configuration
(connection and variable configuration)

You will get to know how to download and start up
You will get to know the FMS call interface

You can use the sample program as a basis for creating PLC
programs

Requirements:

A working knowledge of STEP 7, experience with STL,
experience of PLCs.

If you require detailed information about the
characteristics of the communication introduced here or

other functions provided by the configuration software,
please refer to the corresponding manuals. The preface
~3J of the manuals provides you with an overview of the

available documentation. This chapter also contains
references to specific manuals.

& 6.1 The Task and System Setup 69
6.2 The Example Step-by-Step 71

— Configuring FMS connections 72

— Configuring FMS variables 79

— Creating the user program 82

— Startup/diagnostics 89

6.3 Reporting Variables —
Tips and Information 91
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6.1 The Task and System Setup

Sending and receiving “neutral” data

The communications task illustrated by the sample program has been selected so that the call
interface in the user program and access to variables (FMS client) as well as variable
configuration can be demonstrated:

¢ The “FMS client S7-400 station” reads and writes variables in the “FMS server S7-400
station”.

FMS client FMS server
S7-400 station S7-400 station

E:, ; ] - Write variables ——» Di
’ - Read variables — [

o o}

FMS]obs °§

Q=

%g

o o

MPI interface
MPI interface

PROFIBUS

PG/PC with STEP 7 and NCM S7 for PROFIBUS

Further Features:

The communication is implemented as master-master communication in the acyclic mode, in
other words communication jobs are triggered once due to a job sent by the user program.

The structure of the data is shown on the following pages.
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Required Devices/Resources

You require the following components if you want to use the supplied sample unchanged.

No. Type Order Number:
Required
2 S7-400 programmable controller with CPU See Catalog ST 70
2 CP 443-5 Basic 6 GK7 443-5FX01-0XE0 1)
1 Transmission path see [7/
1 Programming device (PG/PC) with see Catalog ST 70

® STEP 7 V5.2 software or higher installed

® Optional software NCM S7 for PROFIBUS V5.2 or
higher or with the NetPro optional software.

* MPI attachment

* As an option for the PG/PC mode on PROFIBUS: CP
for PROFIBUS attachment —>
diagnostics/installation/service

1) Newer versions of the module are normally compatible in terms of functionality; You can load the
configuration data of the sample project on your module without needing to make changes.
Please read the information in the manual of the CPs on the topic of compatibility and replacing

devices!

Alternatives:

You can adapt the sample configuration to suit your own configuration. Possible modifications
are outlined below:

e Using an S7-300 instead of an S7-400

Instead of an S7-400 station, you can also use S7-300 stations. You would then use a CP
343-5 as the CP.

When you configure the hardware and program the interface, you would have to make the
appropriate adaptations.

¢ Using a different CPU type

In this case, after replacing the CPU using the Drag & Drop function in hardware
configuration, no adaptation is necessary (replacement using Drag & Drop is possible for
compatible modules; refer to the notes in the online help about replacing modules).

¢ Changing the order of the modules in the rack

With certain CPU types, this also changes the module address.

70
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Notice

If you change the module address in the configuration, you must also adapt the
address in the block calls of the user program.

¢ Using a different station, for example SIMATIC S5 or PC

If you use an “other” station as the FMS client or FMS server, you must create it in the
project (for example Insert>Station>SIMATIC S5) and adapt the connection configuration
accordingly.

6.2 The Example Step-by-Step

The following description is based on the created project and the configured stations. The steps
“Create your project” and “Configure and network your hardware” were explained in Chapter 2.

1. Create your project L
[ 2. Configure and network your hardware V Chapter 2
|
|
|
|

| 3. Configuring Communication Variables

| 4. Configure FMS connections \  Section 6.2 / and pages following

| 5. Create your user program

| 6. Startup

To achieve success quickly...

If your system configuration corresponds to the configuration selected for the example, you can
download the sample data directly to the S7 stations in steps 3 and 4.

You will, however, learn more by working through ,TIP

the Steps as outlined in this primer. + Skip the functions that you
' already know.

1 Chapter 2 deals with the topic
' “Downloading”.
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| 1. Create your project

~
V~

| 2. Configure and network your hardware

With the FMS services WRITE
and READ, this is only required
in the stations used as FMS
servers.

3. Configure communication variables

| 4. Configure FMS connections \

| 5. Create your user program \
| 6. Startup \

Sending and receiving “neutral” data
The data are organized as follows in the example:

¢ The variables on the FMS server are stored in one DB1 data block and configured as FMS
communication variables. DB1 contains INTEGERs, ARRAYs and STRUCTSs.

¢ The variables are stored on the FMS client in various data areas. Independent access will
therefore be possible to individual elements in DB1.

The following diagram illustrates the sequence of program execution and communication and
shows the data organization in the FMS client and FMS server:

FMS client EMS server
S7-400 station S7-400 station
DB600 data block o
DB601
| INTEGER | S
ARRAY[] ﬂ) 2
OF BYTE DB1 data block
INTEGER
STRUCT
. . ARRAY[]
Write variables OF BYTE
|
DB500 data block _ STRUCT
DB501 Read variables
| INTEGER | -t
ARRAY]] os202
OF BYTE
STRUCT

"THne
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You can find the DB1 data block of the FMS server in the sample project as follows:

»” Open the program container of the CPU and then the “Blocks” object for the FMS server
S7-400 station

»” Double-click DB1 and open the STL representation of DB1; here shown in the declaration
view.

K SIMATIC Manager - [PROJECT-PROFIBUS -- D:\Siemens\Step7\E xamples'expb] H=]E3
% File Edit Inzett PLC Yiew DOptions ‘Window Help _|ﬁ'|£|
0|82 (& |5l | [= =[5 [ NoFirer > 1% %8=| we|
E"% PROJECT-PROFIBUS
-l FMS-Client 57 400-5tat. D jj-
ES::T;;S] o Systemdaten []=3] DE1 ‘Warigblen beobachten
- agIC
RO RV EWSMMMPSIN { | AD /S TL/FBD - [DB1 -- PROJECT-PROFIBUS\FMS-Server 57 400-5tat ACPU414-1(1)] P[] E3
EI CPU414-1(1) i File Edit Inset PLC Debug MWiew Options MWindow Help _18| x|
D[(e-(a| & & [l@| [ il [ = 1] x|
‘ Type Initial valiComment
F-E SIMATIC 300 DP-M - STRUCT
E-El SIMATIC 300 DP-S| .0] |Index_lo0 INT 1]
EHE SIMATIC 300-Static .0| |Index_101 ARRAY[1..10]
-l SIMATIC 300-5tatio 0 —
F-El SIMATIC 300-5tatio -
.0 [Index_l02 STRUCT
.a Subindex_1 EO0L FALSE
.a Subindex_Z STRING[S] 'Hallo!!'!!
.a Subindex_3 CHAR ot
Prezz F1 to get Help. .0 Subindex_4  [DINT L#0
.a END_STRUCT
.a END_STRUCT
—
Presz F1 to get Help, [ 2 |offine |&bs  [Insert 5

You will recognize the variable structure already introduced consisting of INTEGER, ARRAY

and STRUCT at the overview level of DB1. Tie |
+ To avoid unnecessary use of me- !
, mory for communication variables .
' on the CP, you should, whenever
. possible, only define communica- :

To read or write variables via FMS connections...
...these must be declared as communication variables.

Communication variables only need to be configured on the FMS server, and only in the
following situations:

¢ When you want to use the FMS services WRITE and READ.

¢ When the FMS server is an S7 station. With other station types, refer to the corresponding
manuals and product information bulletins.

The variables only need to be configured on the FMS client if you want to use the REPORT
FMS service.
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As default (can be modified by configuration), the FMS client reads the variable descriptions
using the “GET-OD” FMS service when the connection is established.
Next step: Declare the data block symbolically

» Open the program container “S7 Program(2)” on the FMS server and the “Symbols” object
within it. In the first line, you will see the DB1 data block declared as “Server Variables”.

» Check the setting under View » Columns B,M,C; you will only see the attributes that
provide information about special object properties when this setting is activated.

You can see that the column C=communication is selected in line 1.

KJSIMATIC Manager - [PROJECT-PROFIBUS -- C:\Siemens\5tep7\Examplestexpb] O] x|
% File Edit Inzeit PLC %iew Options “indow Help =l
D[c{22] ] (% il [o s [ [zl o R0 ERE R
[ PROJECTPROFIBUS
FMS-Client 57 400-Stat @
B FMS-Server 57 400-tat. GQuellen Bausteine Symbale
B cru414-11) -
E1-2g 57-Programm(Z] 'ﬁ'gﬁymhol Editor - PROJECT-PROFIBUSAFMS-Server 57 400...\Symbole
@ Guelen Spmbol Table Edit |nset “iew Options ‘window Help
{gH Bausteine — . -
Foraiseacn | 2|H] S Bl | ~1%| a2l
-8 SIMATIC 300 DP-Master
- SIMATIC 300 DP-Slave @i PROJECT-PROFIBUSAFMS-Server 57 400.. \Symbole
- SIMATIC 300-Station(1] ROM|C Symbol Address |Data type Comment
=-F SIMATIC 300-Station(2) 1 K|Server Variahlen [B]=] 1 DB 1
Bl SIMATIC 300-5tation(3] 2 “ariablen beobachten VAT 1
3
Mumber of symbols: 242 v
|

Press F1 to get Help.
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To use the variable as a communication variable...
V~ ...select Edit>Special Properties»Communication.

» Make sure that the “Use Symbol as Communication Variable” option is checked.

E‘gﬁymhol Editor - PROJECT-PROFIBUS\FMS-5erver 57 400.. \Symbole
Swmbol Table Edit  Inzert Yiew Options wWindow Help

S| 8| &= ol [~ =17
Symbol Address Data type Comment
1 [Server Variablen OB 1 DB 1

“ariablen beobachten WAT 1

Communication Properties - Symbol [ %]

W se symbol as communication variable

3

General | Fi5 .&ttributesl Structurel

Sumbal narne: Server Wariablen

Syrmbal comment;

Preszz F1 to get Help.

i odule Assignment.. § Print Y ariable List...

Ok, | Cancel Help

Further settings are only required in the following situations:
¢ When you do not only want to access the entire variable

¢ When you have created an array in a communication variable
¢ When you want to assign attributes for access protection

¢ When you want to change the FMS index

¢ When you want to change the range for reserved indices.
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» In our example, select the “Structure” tab:

DB1 data block Communication Properties - Symbol

W Usze Symbol a5 Communication Y arishle

INTEGER

Generall FMS Attributes  Structure

ARRAYJ]
OF BYTH ! — Sumbolic Acce:
Cor_mgured : o -
variable IV TaoFist 5 “L Iof a DB oo
Hars v b Skt F
descnpnon o First Structure Level of & FMS Base Index:
Mumber of Reserved Indexes: |3—
STRUC

‘Wariable Accesible to Communications Parther:

Wariabls Name | FMS Index | FMS Subindex | S7 Tupe | FMS Type =
Server Yariablen.Index_100 100 INTEGER Integerl &
Server Yariablen Indes_101 101 ARR&AY.1010F  ARRAYTIO]
BYTE Unzigneds —
Server Yariablen. Index_102 102 STRUCT STRUCT

Subindex_1 102 1 BOOL Boolean | *
| |
Index List... |
e | __top |

Why “Symbolic access to first structure level of a DB” was selected in the example

There are two reasons for this:

1. The FMS client can only access individual variables with an FMS write or read job when
this option is selected. The way in which this access is formulated is explained later in the
description of the programming.

2. The data block contains an array; arrays always require exclusive declaration at the first
structure level of a DB! TIP

* When you exit the dialog, you
| receive an error message if you
' forget the rule about arrays.

' You also receive the information
 “Nesting Level Exceeded” in the
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What is the significance of the FMS index?

The FMS index addresses the communication variable in the FMS server. To access the
variable, you can use the FMS index or the variable name.

An FMS index is always assigned to the entire variable. For a variable that is split up at the first
structure level, a base index (the FMS index of the first variable) is assigned and entered in the
table of the FMS index of the individual variables.

Manual

12/

Volume 2
Chapter 3...

When does the FMS base index or number of reserved indices need to be changed?
It is a good idea to get an overview based on the index list.

~ Select the “Index List” button in the “Structure” tab page.

Index List [ %]
FMS index | Warniable name | Status | Comment |
100 Server Vanablen Indes_100
1 Server Variablen.Index_101
102 Server Wanablen Index_102

T s Prirt... | Help |

You will see all the communication variables defined on the S7 CPU. Based on the list you can
detect any mismatches and if necessary correct the index information in the “Structure” tab
page.

As an experiment, you could select the “Symbolic Access to Entire Variable” option in the
“Structure” tab page and then call the index list again. You will then see that an additional FMS
index is assigned but due to the array, the “Nesting Level Exceeded” message indicates a
conflict.
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What resources need to be reserved for the configuration on the FMS server?

The manual provides information about the resources ' If you use more than one CP on

available for the CP you are using. The section “Data for ' the FMS server, you can distribute
FMS Connections” in the product information of the CP ' the load for complex applications.
443-5 Basic, for example, tells you which variables can ' In the variable configuration, you

be configured. » would then use the “Module As-

For the configuration used in the example, a total of four server variables would have to be
included in your calculation, as follows:

Three variables (INTEGER, ARRAY and STRUCT) at the first structure level plus one additional
object for the structure description (here the value for structures should be specified as less
than ten elements).

—

Manual

12/

Volume 2
Section 3.6
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| 1. Create your project

| 2. Configure and network your hardware
| 3. Configure communication variables
4. Configure FMS connections

| 5. Create your user program \
| 6. Startup \

The default settings are adequate
for most requirements.

Checking/configuring connection parameters for the FMS connection

» Open the object PROFIBUS(1) in the project view in the SIMATIC manager. If you select the
CPU in the FMS client station in the NetPro display, you will also see the connection table

with the existing configured FMS connection.

%NE[FID - [PROJECT-PROFIBUS [Network] -- D:\Siemens\Step?\E xamplesiexpb]
%gﬂetwork Edit Inset PLC Yiew Options Window Help

=18]x]

22 (% 8| o] dilil & 2] B! N

MR
P

PROFIBUS (1)
PROFIBUS

L |

FMS-Client 57 400-Stat.

‘S\MATIC 300 DP-Master

CRN[CF
M |zs

L]

SIMATIC 300-Station(1)

CRU [CP
M (32s

=[] 0§
2 10 2 2
‘FMS-Server 57 400-Stat. SIMATIC 300 DP-Slave SIMATIC 300-Station(2)
| [l LN R <11 | ER
=] F’la“: H (@ H B
2 16 2 12 2 B

FPartner I
0 ]

Active connection partner

4

Ready

_’Ill

Figure 6-1

In the example, the properties of the FMS connection have been configured so that a
connection between stations of the specified type can be established and operated

successfully.

A checklist in the manual indicates when settings are required.
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You could now open the properties dialog to check the
consistency of the configured FMS connection.

»~ Select the connection properties by double-clicking
the connection in the connection table.

» Now change to the “Overview” tab page.

The status display “OK” indica-
tes that the connection configu-

General UVEWiBWl Status Infarmation I

ration is correct. .
Lonnections:
.namel F|.-"S| Femote ad... | Local LSAF'l Femote L5... | Statuz
terbi... 044 18 34 34 0K
K0l | i
I | Display conrestions af & CRLs
Fiint Configuration | Frint |

Cancel | Help |

» Now change to the “General” tab page and click the “Options” button.

The settings in the example are selected as follows:

Properties FMS connection cptions [ %]

Comrmunication | Servicesl Partrer Variablesl Fieparting Variablesl Accessl

Type of Communication —Addresse
r
Properties FM5 connection E38 IMMAE 'l Lecal Bemate
PROFIBUS
I =|
General | Dverviewl Status Information I fnasten contechiong address: 14 & |
; LS&P: |34 |34
— Connection Endpaint — Block P. b .§Iave connEciion -
CREF: K bus ID: D/ #164#00010001 iz data ershiangs
Local ID [hex): | v[ |unm v[ e iritiatiye
Mame: IFMS-Verbindung-2 2t carnmnization
Efder
ia CP: |EF' 443-5 Basic - [RO/54) bR
Fioute | e
attribute: ID 'l

— Partner Type

Station profile: S7-400 CP443-5 FMS j

Cancel Help

wl Optianz... |
— I Cancel | Help |

The alternatives in the Properties dialog are not dealt
with in detail here. Simply remember that adaptations are
only necessary in special cases.
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According to the checklist, other reasons for checking or

modifying the properties parameters may be as follows:

e To make sure that the IDs are consistent in the
configuration and the user program

¢ To match the FMS connection profile of the partner

¢ To distribute the load on two or more PROFIBUS CPs

within a station.

Note the following:

Manual

12/

Volume 2
Section 2.6

The FMS client can read or write all the communication variables configured on the FMS

server without special settings.

You can, however, reduce the memory requirements on the CP of the FMS client if you do not
need to read or write all the communication variables configured on the FMS server.

»” Open the Properties dialog of the FMS connection to the “Variables of the Partner” tab page.

Properties FMS connection

Properties FMS connection cptions rmatlon |

Eommunicationl Services Fartner Variables |Hep0rting Valiablesl .t’-‘«c:cessl

— Block Parameters——

D1 6H0001 000

Options.... |

Cancel | Help

K bus ID:
Fead communications partner varable dezcriptions 3 IUUU'I vI
o8 A
- Yiiene Hung-2
" Specified wariables from the list below sic: - [R0/54]
Mames: Indexes:
;I ;I Route... |
43-5 FhS 'I
Import GSD File. .. |
I =
corcel | __teo_|

You will see that we have left the standard settings for the example, in other words all variables
can be accessed by their name or index. Which communication variables exist depends, of
course, on the variable configuration on the FMS server.
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| 1. Create your project

| 2. Configure and network your hardware

| 4. Configure communication variables

ANANANAY

| 3. Configure FMS connections
. Create your user program
| 6. Startup \

— How are the FBs supplied?

— How does the program run?

[ e |
»~ ...select the container with the program blocks in the ‘ ;; Pe 88 deals with the topic of |
. . . ! |
required S7-400 station in the PROJECT PROFIBUS. \ “Dgwnloading” P \
At the detailed display level, you obtain the following T T )
list informing you about all the blocks on the FMS
client.
W4 SIMATIC Manager - [PROJECT-PROFIBUS -- D:ASiemens\Step?\E xamplesexpb] [_[=]
9 Fie Edit Inset PLC Miew Options Window Help =& x|
O]e |87 7] el | [= 25 < Mo Filter > =% 8= E”
[=-Bp PROJECT FROFIBLS | Object name | Symboiic name | kNCw H.. [ Createdin language [ Type | Size in the werk . [ Author [ Name (Hear =
B[l FMS-Client 57 400-5tat. 5 pstemdaten SDE o o
EPU4TAI) o0 STL Organization block. 138
B0 S7-Programm({1) o 0B100 STL Drgarization block 52
(B Ouellen oFe3 READ Yes sTL Furctionblock 2020 SMATIC  READ
& EP%E‘;“::EE"] 0 FBE WRITE Yes STL Functionblock 2024 SIMATIC  WRITE
EM5-Server 57 400-5tal. £ FC100 Index100 READ-&ufruf STL Function 340
SIMATIC 300 DP-Master o FO1m Index101 READ-Aufruf STL Function 340
SIMATIC 300 DP-Slave ik FC102 Index102 READ-Awufruf STL Function 30
SIMATIC 300-Station(1] 40 FC200 Index100 WRITE-Aufruf 5TL Function 40
SIMATIC 300-5tation(2) 3 FC2o Index101 WRITE-Aufruf STL Function 340
SIMATIC 300-5tation(3) 3 FC202 Index102 WRITE-Aufrut STL Function 340
£ FC300 Vergleich Index 100 STL Function 86
€ DE100 Index100 READ-Parameter - DB Data block 54
DB Index101 READ-Parameter - DE Data block 54
3 DET02 Index102 READ-Parameter - 1] Data block 54
4 DEZ00 Index100 WRITE-Parameter -~ DE Data block B2
£+ DBE2M Index101 WRITE-Parameter -~ DE Data block 54
o Dbe202 Index102 WRITE-Parameter DB Data block, 54
4 DB300 Index100 READInstanzDE DB Data block, v
43 DB3m Index101 READ-InstanzDB - - [l:] Data block ard
€ DE302 Index102 READ-InstanzDB - DB Data block ard
€ DE400 Index100 WRITE-nstanzDB - DB Data block 3594
3 DB4M Index101 WRITE-nstanzDB - 1] Data block 294
3 DE40Z Index102 WRITE-InstanzDB -~ DE Data block 334
4 DESOD Index100 Yariable Ziel DE Data block )
4 DBEM Index101 Yariable Ziel DB Data block, 46
4 DBEDZ Index102 Variable Ziel DB Data block, 54
43 DEEOD Index100 Yarishble Quelle [l:] Data block )
€3 DBEOT Index101 Yarishle Quelle DB Data block 46
€ DEEOZ2 Index102 Yarishble Quells DB Data block 54
4 Read/wiite be... Read/write beobachten W ariable table
£k Variablen beob... Wariablen beobachten W ariable table
ik SFB1Z2 BSEND Yes STL Sygtem function b... - SIMATIC BSEMD
4} SFB13 BRCY Ve STL System function b... - SIMATIC BRCVY
4 SFC20 BLKMOY Yes 5TL System function SIMATIC BLKMOW —
ﬂl' SFC24 TEST_DB Yes 5TL | System function SIMATIC TEST_Dil;l
4 r

Press F1 to get Help. | ‘ |
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For a better overview...

»~ ...you should print out the program blocks (OBs, FCs) once and examine them in detail. An
example of how the FBs READ and WRITE are supplied is shown on the following page.

The Program Sequence

Cyclic jobs for reading and writing variables are started on the FMS client. Evaluation of the
return values ensures that a job is completed successfully before the next job is activated.

In this example, the FMS server has no active function in a user program.

FMS client FMS server
S7-400 station S7-400 station
Startup
OB100
Cyclic _ DB1 data block
OB1 processing INTEGER
A Vel ReAD ARRAY]]
| . OF BYTE
Fc200, WRITE
— |
STRUCT
FC101 READ
— 1 >
FC201 His
WRITE connection
| . =
FC102 READ
| |
FC202 WRITE
Key: > Sequence of the CPU cycle

SIMATIC NET NCM S7 for PROFIBUS
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Significance of the Functions (FCs)

Read Process Values:

FC 100

The function demonstrates an example of an FMS communication job with the READ function block
(FB3). A variable of the type Integer is accessed. The variable is stored in DB500.

FC 101
The function demonstrates an example of an FMS communication job with the READ function block
(FB3). A variable of the type Array is accessed. The variable is stored in DB501.

FC 102
The function demonstrates an example of an FMS communication job with the READ function block
(FB3). A variable of the type STRUCT is accessed. The variable is stored in DB502.

Writing Process Values:

FC 200

The function demonstrates an example of an FMS communication job with the WRITE function block
(FB6). A variable of the type Integer is transferred from DB600.

FC 201
The function demonstrates an example of an FMS communication job with the WRITE function block
(FB6). A variable of the type ARRAY is transferred from DB601.

FC 202
The function demonstrates an example of an FMS communication job with the WRITE function block
(FB6). A variable of the type STRUCT is transferred from DB602.

Notice

When using a CPU 412/413, the data blocks DB60x must be renamed and
assigned a new number =< DB511.

For the CPU 31x, all DB numbers must be changed with a value =< 127.
You must also

— adapt the symbol tables;

— recompile the blocks;

— recreate the instance DBs

Programming FBs for communication

For handling communication on the FMS connections in the sample program, two blocks of the
type FB are available:

e FB WRITE (FB6) for more detajled in- —
The block transfers user data for transferring data to ~ formation... Manual
the PROFIBUS CP. N 2/

e FB READ (FB3) Volume 2
The block enters the received user data in the user )
data area specified in the call. Section 7.3

SIMATIC NET NCM S7 for PROFIBUS
84 C79000-G8976-C113-03



Communication on FMS Connections

The user program in our example was created in STL
notation. The diagram below illustrates an example of the
parameters assigned for the WRITE and READ call.

Example of writing to a structure:

FMS client FMS server
S7-400 station S7-400 station
.
DB602
DB1 data block
INTEGER
STRUCT
ARRAYT(]
OF BYTE
Write variable
]
STRUCT
vTime
STL for FC202 Expl anati on
CALL "WRI TE” , "Index102 WRI TE i nst anceDB" /I WRI TE bl ock call
REQ :="1ndex102 WRI TE paraneter”. Wite_REQ /1 Trigger job
1D :="1 ndex102 WRI TE paraneter”. Wite_I D /] Connection ID
VAR 1 :="1ndex102 WRI TE paranmeter”. Wite_VAR Index //Destination: indexed
SD 1 :="Index102 variabl e source”.|ndex_102 /1 Address of data source
DONE :="1ndex102 WRI TE paraneter”. Wite_Done /] Return pararneter DONE
ERROR : ="1 ndex102 WRI TE paraneter”. Wite_Error /] Return paraneter ERROR
STATUS: =" I ndex102 WRI TE paraneter”. Wite_Status /] Return paraneter STATUS

Note that the call parameters in the example are declared and assigned as symbols.

For the complete code of these FBs and the other OBs and FCs, refer to the printouts of the
sample project.
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Example of reading an array:
FMS client FMS server
S7-400 station S7-400 station
.
DB1 data block
INTEGER
Read variable
DB501 ARRAYJ]
OF BYTE
ARRAYT(]
OF BYTE
STRUCT
Time
STL for FC101 Expl anati on
CALL "READ’ , "Index101 READ i nstanceDB" /I READ bl ock cal |
REQ :="1ndex101 READ paraneter”. Read_REQ //Bit to trigger job
1D ="1 ndex101 READ paraneter”.Read_| D /] Connection ID
VAR 1 :="1ndex101 READ paraneter”. Read_VAR | ndex /] Source: indexed
RD 1 ="1 ndex101 vari abl e dest”.|ndex_101 /1 Address of data
NDR  :="1ndex101 READ paraneter”.Read_NDR destination
ERROR : ="1 ndex101 READ paraneter”. Read_Error /] Return paraneter DONE
STATUS: =" | ndex101 READ par anet er”. Read_St at us /] Return paraneter ERROR
/] Return paraneter STATUS

Note that the call parameters in the example are declared and assigned as symbols.

For the complete code of this FB and the other OBs and FCs, refer to the printouts of the

sample project.
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Extending the Sample Program

You can extend the program in several ways either in the sample or later in your own

application, for example:

¢ by evaluating the return values of the READ and WRITE FBs to allow you to react to specific

operating states or errors.

»~ Evaluate the return values DONE, ERROR and for more detajled —
STATUS with READ and NDR, ERROR and information ab Manual
STATUS with WRITE. How to evaluate return N 12/
values is illustrated below:

Volume 2
Job Section 7.3
DONE/NDR =1 DONE/NDR =0 DONE/NDR =0
ERROR =0 ERROR =0 ERROR =1
STATUS =0 STATUS = 000By STATUS =x
Complete without error Active Completed with return value

SIMATIC NET NCM S7 for PROFIBUS
C79000-G8976-C11.3-03

Typical return values (STATUS) that
must be handled by the user program,
for example:

0201H Connection cannot be established

0601y Invalid object

0607 Object does not exist
(usually during startup, if GET_OD is
not yet completely executed)

0608y Type conflict (usually configuration
error)
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To download the user programs to the PLC...

...follow the steps below:

»~ Set the CPU to STOP or RUN-P.

»~ Select the blocks container in the SIMATIC manager in the relevant station.
» Download the entire program (apart from the SDB) using

the function PLC» Download.

"In thé RUN-P mode, the order of the
! blocks is important since the CPU cycle
1 is active. Remember that OB100 is only

» Set the CPU to RUN-P or RUN.

Manual
14/

»” Repeat the download procedure for the other station.

Summary of Step 4 “Creating the User Program”:

You have now done the following:

1. Created the user programs for both S7 station according to the task description.
2. Extended the sample programs, for example by evaluating the status codes

3. Downloaded the user programs to the CPUs of both S7 stations

Result:

You can now follow the execution of in the variable table with “Monitor and Modify
Variables”.

If you cannot detect any communication, do one of the following:
»~ Check the program sequence online in STEP 7/STL.

» Go on to the next step and check communication with PROFIBUS diagnostics.

SIMATIC NET NCM S7 for PROFIBUS
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| 1. Create your project

| 2. Configure and network your hardware

| 3. Configure FMS connections

| 4. Configure FMS connections

| 5. Create your user program

IRV

6. Startup — modify variables/diagnostics

»” Use the modify variables function as follows:
— To initiate jobs (VAT 1)
— To modify or monitor variable values (VAT 2).

With PROFIBUS diagnostics,
you can detect existing
communication problems.

You will find the variable table VAT 1 (monitor read/write) and VAT 2 (monitor variables) in the

block folder of the FMS client.

The figure below shows how to control the program and access the data areas.

Entries that can be

monitored with varia-
ble table VAT 2

FMS client FMS server
S7-400 station S7-400 station
Value changed Data block DB600 _—
by the progral N TEGER DB601
ARRAY(] DB602
OF BYTE Data block DB1
INTEGER
Entries that canbe — | STRUCT ARRAY(]
changed by varia- Write variables OF BYTE
ble table VAT 2 L
STRUCT
Data block DB500 oB50L Read variables
| INTEGER J— B
ARRAY]] 02
OF BYTE
STRUCT

Jobs that can be

conrtolled via

variable table VAT 1

vTime

SIMATIC NET NCM S7 for PROFIBUS
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» For example, use the following NCM diagnostic

90

functions to examine the state of the jobs and FMS
connections.

NCM S7 PROFIBUS Diagnostics
Were FMS connections established?
Job Status

For example, READ job with error
FMS Connection

Were FMS connections established?

for more detailed
information...

~

Manual
12/

Volume 2

Chapter 5
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6.3 Reporting Variables — Tips and Notes

What is the difference compared with reading and writing?

...during operation/in the user program
The report job is sent by the FMS server. A separate FB REPORT is available for this.

On the FMS client that receives the reported variables, no communication jobs are started. The
data areas for the variables to be reported are specified during configuration.

...in the configuration
Reporting variables must be configured on the FMS server and on the FMS client.

On the FMS client, use the additional functions to assign data areas for reported

communication variables. e
for more detailed Manual
information... ~ 12/
Volume 2
Chapter 2

The rules for numbers of connections and amount of data ...

...are the same as in the calculations for configuring read/write.

4
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Manual/ Product Information SIMATIC NET CP
Supplied with each CP
Siemens AG

NCM S7 for PROFIBUS Manual
Part of the documentation package NCM S7 for PROFIBUS
Siemens AG

NCM S7 for Industrial Ethernet manual
Siemens AG

SIMATIC STEP 7 User Manual
Part of the standard STEP 7 Documentation Package
Siemens AG

SIMATIC STEP 7 Programming Manual
Part of the standard STEP 7 Documentation Package
Siemens AG

SIMATIC STEP 7 Reference Manual
Siemens AG

PROFIBUS NetworkS Manual
Siemens AG

EN 50170, Vol 2
Beuth Verlag, Berlin 07/94

SINEC CP 5412 (A2)
Manuals for MS-DOS, Windows
Siemens AG

SIMATIC S7

S7-300 Programmable Controller
Hardware and Installation

Manual
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Order Numbers

SINEC

CP 5430 TF with COM 5430 TF,
CP 5431 FMS with COM 5431 FMS
Manual

SIEMENS AG

The order numbers for the SIEMENS documentation listed above can
be found in the catalogs “SINEC Industrial Communication, Catalog
IK PI” and “SIMATIC Programmable Controllers SIMATIC S7/ M7/ C7".

You can obtain these catalogs and any further information you require
from your local SIEMENS office or national head office.
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